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Antes de empezar
Esta sección contiene la siguiente información:

Soporte 6

Notas legales 6
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Antes de empezar
Soporte

Soporte
Si necesita soporte técnico, póngase en contacto con su distribuidor MOBOTIX. Si su distribuidor no puede 
ayudarle, se pondrá en contacto con el canal de soporte para obtener una respuesta lo antes posible.

Si dispone de acceso a Internet, puede abrir el servicio de soporte técnico de MOBOTIX para buscar infor-
mación adicional y actualizaciones de software. Visite:

www.mobotix.com > Support > Help Desk (www.mobotix.es > Soporte > Servicio de asistencia)

 

Notas legales

Aspectos legales de la grabación de vídeo y sonido
Debe cumplir todas las normativas de protección de datos para el control de vídeo y sonido cuando utilice 
productos MOBOTIX AG. Según la legislación nacional y la ubicación de instalación de las cámaras, la gra-
bación de datos de vídeo y sonido puede estar sujeta a documentación especial o puede estar prohibida. Por 
lo tanto, todos los usuarios de productos MOBOTIX deben familiarizarse con todas las normativas aplicables y 
cumplir estas leyes. MOBOTIX AG no se hace responsable del uso ilegal de sus productos.

Declaración de conformidad
Los productos de MOBOTIX AG están certificados de acuerdo con las normativas aplicables de la CE y de otros 
países. Puede encontrar las declaraciones de conformidad para los productos de MOBOTIX AG en www.-
mobotix.com en Support > Download Center > Certificates & Declarations of Conformity 
(Soporte > Centro de descargas > Certificados y declaraciones de conformidad).

Declaración de RoHS
Los productos de MOBOTIX AG cumplen plenamente con las restricciones de la Unión Europea sobre el uso 
de determinadas sustancias peligrosas en aparatos eléctricos y electrónicos (Directiva 2011/65/UE) (RoHS) en 
cuanto a su sujeción a estas normativas (para obtener la declaración de RoHS de MOBOTIX, consulte www.-
mobotix.com, Support > Download Center > Documentation > Brochures & Guides > Certificates [Soporte 
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> Centro de descargas > Documentación > Folletos y guías > Certificados]).

Eliminación
Los productos eléctricos y electrónicos contienen numerosos materiales valiosos. Por este motivo, le reco-
mendamos que deseche los productos de MOBOTIX al final de su vida útil de acuerdo con todos los requisitos 
legales y normativas (o deposítelos en un centro de recogida municipal). Los productos de MOBOTIX no 
deben desecharse en la basura doméstica. Si el producto contiene alguna batería, deséchela por separado 
(los manuales del producto correspondientes contienen instrucciones específicas cuando el producto con-
tiene alguna batería).

Descargo de responsabilidad
MOBOTIX AG no asume ninguna responsabilidad por daños que sean a consecuencia de un uso inadecuado o 
de un incumplimiento de los manuales o de las normas y reglamentos aplicables. Se aplican nuestros tér-
minos y condiciones generales. Puede descargar la versión actual de los Términos y condiciones generales 
de nuestro sitio web en www.mobotix.com, haciendo clic en el enlace correspondiente en la parte inferior de 
cada página.

Exención de responsabilidad de la FCC
Este equipo ha sido probado y cumple con los límites para dispositivos digitales de clase A, de acuerdo con la 
sección 15 de las normas de la Comisión Federal de Comunicaciones (FCC por sus siglas en inglés). Estos lími-
tes están diseñados para proporcionar una protección adecuada contra interferencias perjudiciales cuando el 
equipo se utilice en un entorno comercial. Este equipo genera, utiliza y puede irradiar energía de radio-
frecuencia y, si no se instala y utiliza de acuerdo con el manual de instrucciones, puede provocar inter-
ferencias perjudiciales en las comunicaciones de radio. Es probable que el uso de este equipo en una zona 
residencial cause interferencias perjudiciales, en cuyo caso el usuario deberá corregir las interferencias por su 
cuenta.

Antes de empezar
Notas legales
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Visión General
Notas legales

Visión General
El software de gestión centralizada (CMS) es un sistema de supervisión centralizado y profesional diseñado 
para toda la gama de aplicaciones y proyectos. Con CMS, el acceso y la supervisión de varias herramientas de 
vigilancia como NVR, Codificadores y Cámaras IP están a solo unos clics de distancia. La vigilancia inteligente, 
repleta de funciones, ofrece a los usuarios profesionales experiencias de vigilancia completas y mejoradas.
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Requisitos del sistema
A continuación se enumeran los sistemas informáticos recomendados para instalar el 
software de CMS.

Elemento Descripción

CPU Mínimo: Intel CPU Core i3-4150 3,5 GHz

Recomendado: Intel CPU Core i7-4770S 3.9 GHz

Memoria RAM Mínimo: 2x4 GB

Recomendado: 2x8 GB

Gráficos Mínimo: Intel HD Graphics 4400

Recomendado: Intel HD Graphics 530 o superior

(Admite salida de vídeo 4K)

HDD Mínimo: 1 TB o más

Recomendado: 2 TB o más

Sistemas ope-
rativos

Microsoft® Windows® 8,1 (x64)

Microsoft® Windows® 10 (x64) (recomendado)
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Requisitos del sistema
Instalación del software de CMS

Elemento Descripción

Ethernet Gigabit LAN

Entrada de la 
cámara IP

Máximo recomendado: Vista en tiempo real de 128 canales con gra-
bación de 32 canales

AVISO! Si los gráficos no son gráficos Intel, puede producirse un error mientras se ejecuta CMS. Por lo 
tanto, se recomienda encarecidamente activar la función Software Decode (Descodificación del software) 
para garantizar que CMS se puede ejecutar sin problemas. Vaya a Setup (Configuración) > General y active 
Software Decode (Descodificación del software) para activar la función de decodificación del software.

Instalación del software de CMS
Siga los pasos que se indican a continuación para instalar CMS a un equipo local.

 1. Compruebe el sistema del PC para ver si CMS cumple los requisitos del sistema.
 2. Haga doble clic en CMS_Setup.exe.
 3. Aparecerá la ventana del asistente de instalación de CMS. Siga el asistente de instalación para instalar 

CMS.
 4. Seleccione la carpeta de destino y los accesos directos de CMS.
 5. Seleccione los componentes que desea instalar. Se recomienda seleccionar Disable IIS Service (Reco-

mmended) (Deshabilitar el servicio IIS (Recomendado) para garantizar que CMS se puede ejecutar sin pro-
blemas.

AVISO! Si los usuarios desean cargar la configuración predeterminada de CMS, active Default Setting 
(Configuración predeterminada). De lo contrario, no active esta opción.

 6. Una vez finalizada la instalación de CMS, haga clic en Finish (Finalizar) para salir. Consulte la sección 
Requisitos del sistema para obtener más información sobre los requisitos del sistema de CMS.

Start-ups de CMS
Para iniciar CMS, haga clic en Start > Programs > (Inicio > Programas) CMS. También puede hacer doble clic 
en el icono de acceso directo del escritorio o ir a "\CMS\EXE\" y hacer doble clic en el icono de CMS.
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Iniciar sesión / Cerrar sesión
Una vez que el CMS se inicie, aparecerá la ventana principal de CMS y la cuenta de usuario predeterminada 
será "Guest" (Invitado).

 1. Para iniciar sesión en el sistema de CMS como administrador, haga clic en la cuenta  situada en 

la parte superior derecha de la ventana y seleccione . Aparecerá una ventana de inicio de 

sesión.

 2. Seleccione la cuenta de administrador "Admin" (Administrador) e introduzca la contraseña predefinida 
"123456".

 3. A continuación, haga clic en  para iniciar sesión en CMS como administrador.

 4. Para cerrar la sesión de una cuenta de usuario, haga clic en el nombre de usuario y seleccione 

.

AVISO! 
Se recomienda encarecidamente cambiar la contraseña predeterminada para evitar que se produzcan acce-
sos no autorizados.

Requisitos del sistema
Iniciar sesión / Cerrar sesión
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Vista en vivo
La ventana Live View (Vista en tiempo real) de CMS aparece después del inicio. La siguiente 
sección describe cada uno de los elementos de Live View (Vista en tiempo real).

Esta sección contiene la siguiente información:

Ventana Live View (Vista en tiempo real) 14

Modo de visualización 17

View Layout Setup (Configuración del diseño de la vista) 18

Configuración de E-Map 20

Instantánea 23

Activación/desactivación de audio (habla/escucha) 24

Zoom digital 25

Iconos de eventos 25

Iconos de ajuste de imagen 25

Control PTZ de la cámara 26

Configuración de imagen de la cámara 33

Formato de vídeo de la cámara 34

Configuración de la detección de movimiento de la cámara 34

Configuración de la detección de audio de la cámara 36

Configuración de la programación de la cámara 37
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Vista en vivo
Ventana Live View (Vista en tiempo real)

Configuración del análisis de vídeo de la cámara 37

Configuración de la corrección del ojo de pez de la cámara 40

Configuración de una máscara de cámara 44

Configuración de superposición de texto de cámara 45

Configuración de la alarma de la cámara 47

Configuración de IR/exposición de la cámara 47

Configuración del sistema de la cámara 48

Información de la cámara 49

Ventana Live View (Vista en tiempo real)

Fig. 1: Ventana Live View (Vista en tiempo real)

N.º Artículo Descripción

1 Pestañas de fun-
ción

Las pestañas de función son Live View (Vista en tiempo real), Playback / Export 
(Reproducción/exportación), Add Device (Añadir dispositivo), Record Setup (Con-
figuración de la grabación), Setup (Configuración) y Log (Registro).

2 Login/Logout 
(Iniciar sesió-
n/Salir)

Inicie sesión en el sistema CMS con una cuenta de usuario autorizada o cierre la 
sesión de la cuenta iniciada actualmente.
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N.º Artículo Descripción

3 System Info 
(Información 
del sistema)

Haga clic en  para ver el panel System Info (Información del sistema) de CMS. Aquí 

se puede consultar la información básica de CMS, por ejemplo la versión de software 
de CMS, el estado de la CPU, el uso de RAM (memoria), etc.

Vuelva a hacer clic en el icono para ocultar el panel.

4 Instant Noti-
fication (Noti-
ficación 
inmediata)

Haga clic en  para mostrar el centro de notificaciones.

 n Sistema: si la velocidad de lectura/escritura es lenta o la temperatura de la 
CPU alta, aquí aparecerán los mensajes de advertencia.

 n Device (Dispositivo): Cuando se activa un evento de cámara IP, aquí aparecen 
los mensajes de alerta.

5 Date/Time 
(Fecha/hora)

Muestra información actualizada de fecha/hora.

6 Conceptos bási-
cos de las ven-
tanas

Para minimizar, maximice y cierre el software de CMS.

7 Modo de visua-
lización

Los modos de visualización son de 4 ventanas, 9 ventanas, 16 ventanas, 25 ventanas, 
36 ventanas, 49 ventanas, 64 ventanas, 100 ventanas, 128 ventanas, vista completa y 
visualización secuencial (Nº 9).

8 Instantánea Haga clic para capturar la vista actual de las pestañas Live View (Vista en tiempo real) 
o Playback / Export (Reproducción/exportación).

9 Sequence Dis-
play (Visua-
lización en 
secuencia)

Esta función se utiliza para visualizar secuencialmente los vídeos de visualización en 
tiempo real desde las cámaras IP conectadas, a fin de no tener que cambiar manual-
mente entre vídeos.

Seleccione el tiempo de permanencia de la secuencia y active la casilla para habilitar 
la visualización secuencial.

10 View Layout 
Setup (Con-
figuración del 
diseño de la 
vista)

Puede elegir el diseño de pantalla deseado seleccionando Hybrid View Auto Layout 
(Diseño automático de vista híbrida) o Hybrid View Custom Layout (Diseño per-
sonalizado de vista híbrida).

 n Hybrid View Auto Layout (Diseño automático de vista híbrida): El CMS ajusta 
automáticamente el diseño al formato adecuado cuando se añaden nuevos dis-
positivos IP a CMS.

 n Hybrid View Custom Layout (Diseño personalizado de vista híbrida): los usua-
rios pueden definir ellos mismos su diseño de pantalla mediante esta función. 
El CMS permite configurar un máximo de 4 diseños de pantalla. En la sección 
siguiente se describe en más detalle cómo configurar un diseño de pantalla.

Vista en vivo
Ventana Live View (Vista en tiempo real)
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Vista en vivo
Ventana Live View (Vista en tiempo real)

N.º Artículo Descripción

11 Ocultar paneles 
de función

Haga clic en  o  para ocultar o mostrar View Management Pane (Panel de ges-

tión de vistas) y Camera Setup Pane (Panel de configuración de la cámara).

12 Gestión de vis-
tas

 n Normal Mode (Modo normal): Aquí se enumeran todos los sitios de cámara que 
están conectados actualmente. CMS clasifica los dispositivos IP en tres grupos: 
<Lista de cámaras IP>, <Lista del NVR> y <Lista de codificadores>. 
Active cualquiera de las casillas para mostrar sus sitios correspondientes. 
Active todas las casillas para recopilar y mostrar todos los sitios de cámara.

 n : [R] indica que CMS está grabando la transmisión 

desde este sitio. También aparecerá un icono de grabación  en la parte infe-

rior izquierda de la parrilla de canales.
 n E-Map Function Mode (Modo Función E-Map): Los usuarios pueden importar el 

diseño de las áreas de supervisión y colocar la ubicación de las cámaras en el 
mapa. Vaya a la sección Configuración de E-Map para obtener más infor-
mación.

 n Modo Displayed List/Undisplayed List (Lista mostrada/Lista no mostrada) (solo 
Custom Layout "Diseño personalizado"): En este modo, los usuarios pueden 
decidir qué canales de los dispositivos IP conectados mostrar / ocultar para 
cada diseño personalizado. La <Lista mostrada> indica los dispositivos IP mos-
trados actualmente y la <Lista no mostrada> indica los que están ocultos.

13 Paneles de con-
figuración de la 
cámara

Se pueden configurar varios ajustes principales de las cámaras IP a través de CMS y 
también se puede ver su información básica. Cada panel de configuración se describe 
en detalle en secciones posteriores.

14 Barra de título 
de la cámara

La barra de título de la cámara aparece sobre cada parrilla de canales. Puede com-
probar el estado de conexión de una cámara IP por su color.

 n Gris: cuando el CMS (1) se inicia por primera vez o (2) no tiene ninguna cámara 
IP conectada, la barra de título aparece en gris, lo que indica que no hay nin-
guna cámara IP conectada a la parrilla de canales.

 n Verde: una barra de título de color verde indica que el CMS se está conectando 
a la cámara IP.

 n Azul: una barra de título de color azul indica que la conexión entre el CMS y la 
cámara IP es correcta.

 n Rojo: una barra de título de color rojo indica que hay un error de conexión 
entre el CMS y la cámara IP.
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Modo de visualización
 1. Haga clic en cualquier icono de visualización para ver las imágenes de la cámara conectada en los modos 

de ventana múltiple. Los modos de visualización disponibles son los siguientes:
 —  (4 ventanas)

 —  (9 ventanas )

 —  (16 ventanas)

 —  (25 ventanas)

 —  (36 ventanas)

 —  (49 ventanas)

 —  (64 ventanas)

 —  (100 ventanas)

 —  (128 ventanas)

 —  (vista completa)

 —  (visualización en secuencia)

 2. Haga clic en cualquier icono para ver el modo de visualización seleccionado.

 n Haga clic en  y seleccione un número de página para ver las cámaras anteriores o siguientes del 

grupo de vistas.
 n Para ver un canal determinado en modo de un solo canal, haga doble clic en la parrilla de canales.
 n Vuelva a hacer doble clic para salir del modo de un solo canal.

Sequence Display (Visualización en secuencia)

Seleccione el tiempo de permanencia de la secuencia en el menú desplegable y active la casilla para habilitar 
la visualización secuencial.

Si está activada la opción <Enable Event Full Screen View> (Habilitar vista de pantalla completa de eventos) y 
se activa un evento al ejecutar la visualización secuencial, CMS reanudará la secuencia hasta que finalice la 
pantalla completa del evento.

Modo Vista completa

 1. Haga clic en  para ver la ventana de vistas en vista completa.

En el modo de vista completa, mueva el cursor del ratón hacia la parte superior central del monitor y apa-
recerá una barra de funciones flotante como la que aparece a continuación.

Vista en vivo
Modo de visualización
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Vista en vivo
View Layout Setup (Configuración del diseño de la vista)

 2. Haga clic en  para conectar la barra de funciones. Es posible capturar la imagen actual haciendo clic 

en .

 3. Para salir del modo de vista completa, haga clic en .

View Layout Setup (Configuración del diseño de la 
vista)
Puede configurar el diseño de pantalla que desee de CMS. Seleccione < Hybrid View Custom Layout> (Diseño 
personalizado de vista híbrida) y los elementos de configuración se mostrarán como aparece a continuación.

Fig. 2: Adición/cambio de nombre/eliminación de un diseño de pantalla

 1. Haga clic en Add (Añadir). Se añade un nuevo diseño a la lista de diseños.
 2. Haga clic con el botón derecho del ratón en el nombre del diseño y seleccione Edit name (Editar nombre) 

en el menú desplegable. Aparecerá una ventana de configuración.

 3. Establezca el nombre del diseño y haga clic en OK para guardar y aplicar la configuración.
 4. Haga clic con el botón derecho del ratón en el nombre del diseño y seleccione Remove (Borrar) en el 

menú desplegable. El diseño se eliminará de la lista de diseños.

Edición de un diseño de pantalla

Siga estos pasos para configurar un diseño de pantalla.
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Fig. 3: Edición de un diseño de pantalla

 1. Seleccione un diseño en la lista de diseños.

 2. Haga clic en  para acceder al modo de configuración de diseño.

 3. Para cambiar el tamaño de una parrilla de canales, primero haga clic en ella. Haga clic y arrastre cual-
quier esquina del marco amarillo para dibujar un diseño de parrilla. Al finalizar el dibujo, suelte el botón 
del ratón.

 4. Para añadir más parrillas de canales, haga clic en Add Column (Añadir columna) o Add Row (Añadir fila). 
También puede hacer clic en Remove Column (Eliminar columna) o Remove Row (Eliminar fila) para qui-
tar las columnas o las filas que se hayan añadido.

 5. Es posible intercambiar dos canales diferentes. Haga clic y arrastre un canal desde su parrilla original 
hasta la parrilla deseada y suelte el canal.

Vista en vivo
View Layout Setup (Configuración del diseño de la vista)
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Vista en vivo
Configuración de E-Map

 6. Haga clic en Save (Guardar) para guardar y aplicar los ajustes.

Gestión de los canales mostrados/no mostrados de un diseño

Siga los pasos que se indican a continuación para establecer los canales mostrados/no mostrados.

Fig. 4: Gestión de los canales mostrados/no mostrados de un diseño

 1. Seleccione un diseño en la lista de diseños.
 2. Haga clic en Edit (Editar) para acceder al modo de configuración de diseño.
 3. Seleccione los canales que desee que se muestren para el diseño y, a continuación, agrupe los canales en 

la esquina superior izquierda del diseño.
 4. Retire los canales que no desee de los canales que desea. Si fuera necesario, haga clic en Add Column 

(Añadir columna) o Add Row (Añadir fila) para dejar espacio para los canales no deseados.
 5. Haga clic en Remove Column (Eliminar columna) o Remove Row (Eliminar fila) para retirar las parrillas 

de canales redundantes. Los canales no deseados se desactivarán automáticamente.
 6. Haga clic en Save (Guardar) para guardar y aplicar los ajustes.
 7. Consulte el panel de Gestión de vistas. Asegúrese de que la "Displayed List" (Lista mostrada) incluye los 

dispositivos IP que se van a mostrar, al igual que la "Undisplayed List" (Lista no mostrada).

Configuración de E-Map
E-Map permite ilustrar las posiciones de las cámaras en una imagen autoseleccionada.

 1. En el Panel de gestión de vistas, seleccione E-Map para mostrar el panel de configuración de E-Map. Siga 
las instrucciones para configurar E-Map.
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Fig. 5: Agregar mapas

 1. Seleccione Global Map > Add > Add Map (Mapa global > Agregar > Agregar mapa). También puede hacer 
clic con el botón derecho del ratón en Global Map > Add Map (Mapa global > Agregar mapa).

 2. Haga clic y seleccione una carpeta de archivos.
 3. Seleccione un archivo de mapa y haga clic en OK.
 4. Establezca un nombre para el mapa y haga clic en Apply (Aplicar). El mapa se añadirá a la lista de mapas.

 5. Haga clic y arrastre el icono de ubicación de Google Maps  a la ubicación que desee y, a continuación, 

suéltelo.

Actualización de mapas

 1. Seleccione cualquier Mapa en el menú E-Map y haga clic en Edit (Editar). Aparecerá la ventana para edi-
tar el mapa.

 2. Modifique el nombre del mapa o actualice los mapas cargando nuevos mapas.
 3. Haga clic en Apply (Aplicar) para guardar la configuración.

Implementación de la función de Google Maps

Puede añadir mapas con ubicación geográfica en Google Map.

 1. Haga clic y arrastre el icono de ubicación de Google Maps a la ubicación que desee. Utilice o  para 

acercar o alejar Google Map para buscar la ubicación.

 2. Haga clic y arrastre el icono de Pegman  hasta la ubicación que desee.

 3. Suelte el icono Pegman  en el mapa y la pantalla se acercará a la vista de calle.

 4. Añada un nuevo mapa a la ubicación/el área deseada. Una vez añadido el mapa, se mostrará el icono de 

ubicación de Google Maps en el mapa.

 5. Mueva el cursor del ratón a  y los usuarios podrán obtener una vista previa del mapa.

 6. Haga doble clic en  para mostrar el mapa.

 7. Para volver a ubicar el mapa, haga clic y arrastre  hasta la ubicación que desee y suéltelo.

Vista en vivo
Configuración de E-Map
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Vista en vivo
Configuración de E-Map

Añadir cámaras

Siga estos pasos para añadir cámaras al mapa.

 1. Seleccione un mapa en el menú de mapa.
 2. Paso 2. Haga clic en Add (Añadir) > Add Camera (Añadir cámara). También puede hacer clic con el botón 

derecho del ratón en el nombre del mapa y seleccionar Add Camera (Añadir cámara).
 3. Seleccione una cámara de la lista desplegable Camera (Cámara).
 4. Introduzca el nombre de la cámara.
 5. Seleccione el tipo de cámara, IP Cam (Cámara IP) o Fisheye (Ojo de pez).
 6. Haga clic en Apply (Aplicar). La cámara se añadirá al mapa.

Editar cámaras

Los usuarios pueden revisar los nombres de las cámaras añadidas o sustituirlas.

 1. Seleccione cualquier cámara en el menú E-Map y haga clic en Edit (Editar). También puede hacer clic con 
el botón derecho en cualquier cámara de la lista de mapa y seleccionar Edit (Editar). Aparecerá la ven-
tana Camera Setup (Configuración de cámara).

 2. Restablezca el nombre de la cámara o cambie la cámara.
 3. Haga clic en Apply (Aplicar) para guardar la configuración.

AVISO! 
El cambio de cámara no afectará a la posición original de los iconos de cámara en el mapa.

Cambiar la ubicación de la cámara en E-Map

Después de añadir cámaras al mapa, utilice las siguientes instrucciones para asignar a la cámara una ubi-
cación en el mapa, siendo esta la ubicación exacta de la cámara.

Fig. 6: Cambiar la ubicación de la cámara en E-Map
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Icono Descripción Icono Descripción

Cámara IP / Cámara PTZ Cámara ojo de pez

Artículo Acción Descripción

A Mostrar Live View (Vista 
en tiempo real) de la 
cámara

Haga doble clic en el icono de la cámara para mostrar la vista en 
tiempo real de la cámara. Vuelva a hacer doble clic para ocultar la vista 
previa.

Reubicar el icono de la 
cámara

Haga clic y arrastre el icono hasta la ubicación deseada.

B Ajustar el campo de 
visión de la cámara

Haga clic, mantenga pulsado y arrastre cualquiera de los puntos para 
ajustar el campo de visión de la cámara.

C Ajustar la dirección de la 
cámara

En los campos de visión de la cámara (triángulo), haga clic, mantenga 
pulsado y arrastre para girar la dirección del icono de la cámara.

AVISO! 
Cuando se cambie el tamaño de la ventana CMS, cambiará la posición de los iconos de la cámara en el 
mapa.

Borrar cámaras

 1. Seleccione cualquier cámara en el menú E-map y haga clic en Delete (Eliminar) para eliminar la cámara 
del mapa.

Eliminar mapas

 1. Seleccione cualquier mapa en el menú E-map y haga clic en Delete (Eliminar). También puede hacer clic 
con el botón derecho en cualquier mapa de la lista de mapas y seleccionar Delete (Eliminar). El mapa 
seleccionado se eliminará de la lista.

Instantánea
CMS permite capturar la imagen visualizada actualmente en Normal Viewing Mode (Modo de visualización nor-
mal) o en la pestaña Playback/Export (Reproducción/exportación). La resolución de la instantánea está esta-
blecida en 1080p.

Vista en vivo
Instantánea
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Vista en vivo
Activación/desactivación de audio (habla/escucha)

 1. Haga clic en  en la parte superior derecha del monitor para capturar la vista actual. Aparece la vista 

previa de la instantánea.

Fig. 7: Vista previa de la instantánea

 2. Haga clic en Save (Guardar) y seleccione una carpeta de destino en el cuadro de diálogo emergente Guar-
dar archivo.

 3. Haga clic en Save (Guardar) para guardar la imagen capturada y haga clic en Discard (Descartar) para 
cancelar la operación.

Activación/desactivación de audio (habla/escucha)
La función Audio (Talk/Listen) (Audio [habla/escucha]) se usa para activar/desactivar el audio en el canal de 
la cámara IP seleccionada.

 1. Mueva el cursor del ratón a cualquier parrilla de canales y haga clic en el icono Audio  para mostrar el 

menú desplegable tal y como se muestra a continuación.

 2. Seleccione Listen On/Off (Activar/desactivar escucha) para que CMS reciba audio de la cámara. Aparece 

un icono de altavoz  en la parte inferior izquierda de la parrilla de canales como recordatorio.

 3. Seleccione esta opción nuevamente para desactivar la función de escucha.
 4. Seleccione Talk On/Off (Activación/desactivación de habla) para activar la transmisión de audio de CMS 
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a la cámara.
 5. Seleccione esta opción nuevamente para desactivar la función de habla.

AVISO! La función de audio solo se puede activar en un canal cada vez.

Zoom digital
Es posible acercar o alejar las imágenes mediante la función de zoom digital.

 1. Coloque el cursor del ratón sobre cualquier parrilla de canales y gire hacia arriba o hacia abajo la rueda 
del ratón para acercar o alejar la imagen. El factor de zoom se muestra en la esquina superior izquierda 
de la parrilla. La ampliación máxima es 10x.

 2. Haga clic y arrastre el ratón para ver lo que desee.

Iconos de eventos
Cuando se produce una alarma o evento, aparece el icono correspondiente en la parte inferior izquierda de la 
parrilla de canales.

Icono Descripción

Detección de movimiento

Entrada de alarma activada

Detección de eventos de VA

Iconos de ajuste de imagen
Mueva el cursor del ratón a cualquier parrilla de canales para mostrar y utilizar el icono de ajuste de imagen 
situado en la parte inferior derecha de la parrilla de canales.

Vista en vivo
Zoom digital
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Vista en vivo
Control PTZ de la cámara

Icono Descripción

Gira la vista 90°

Rellena la parrilla de canales

Recupera la relación de aspecto original

Control PTZ de la cámara
CMS admite la función de control PTZ. En Live View (Vista en tiempo real), seleccione un canal de la cámara 
que admita la función de panorámica/inclinación/zoom y amplíe el panel de control PTZ de la cámara a la 
izquierda del monitor.

Iconos de control PTZ

Aquí se pueden configurar los puntos preestablecidos y el recorrido de la cámara.
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Icono Descripción Icono Descripción Icono Descripción

Enfoque lejano

Haga clic sobre él 
para enfocar el obje-
tivo de la cámara 
seleccionada en un 
punto más alejado.

Enfoque cercano

Haga clic en él para enfocar el 
objetivo de la cámara selec-
cionada en un punto más cer-
cano

Iris cerrado

Haga clic en él para 
reducir el iris en la 
cámara seleccionada.

Iris abierto

Haga clic en él para 
abrir el iris en la 
cámara seleccionada

Alejar

Haga clic en él para alejar el obje-
tivo en la cámara seleccionada. 
Esta función sirve para reducir la 
imagen actual y conseguir un 
área de visualización más 
grande.

Acercar

Haga clic en él para 
acercar el objetivo de 
la cámara selec-
cionada. Esta función 
permite ampliar un 
área determinada.

Para implementar el 
ajuste continuo de 
enfoque/iris/zoom, 
mantenga pulsado el 
icono.

Configurar recorrido

Esta función permite 
configurar como 
máximo 8 recorridos 
de la cámara.

Ir a recorrido

Ejecute la ruta de recorrido para 
su visualización.

Configurar prees-
tablecido

Esta función sirve 
para configurar una 
posición determinada 
como punto prees-
tablecido.

Ir a preestablecido

Vaya a las posiciones 
predefinidas para su 
visualización.

Enfoque automático

El enfoque de la cámara selec-
cionada se ajustará auto-
máticamente.

Eliminar prees-
tablecido

 1. Haga clic en los iconos de control de PTZ para acercar/alejar, enfocar, abrir/cerrar el iris y controlar la 
panorámica/inclinación de PTZ.

Panel de control de dirección

La velocidad de panorámica/inclinación depende de la distancia entre el botón de control y el panel de con-
trol de dirección. Cuanto más lejos se arrastre el botón de control desde el centro del panel, más rápida será 
la velocidad de panorámica/inclinación y viceversa.

Vista en vivo
Control PTZ de la cámara
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Vista en vivo
Control PTZ de la cámara

 1. Haga clic y arrastre el botón de control (en el centro del panel) para desplazar/inclinar el objetivo de la 
cámara seleccionada.

Configuración de puntos preestablecidos

Con CMS los usuarios pueden configurar posiciones predefinidas. La cantidad de puntos preestablecidos 
depende del fabricante de la cámara. Siga estos pasos para configurar los puntos preestablecidos.

 1. Haga clic en un canal de la cámara que proporcione la función de punto preestablecido.
 2. Seleccione un número en la lista de puntos preestablecidos.
 3. Utilice el panel de control de dirección para modificar la panorámica/inclinación de la cámara hasta la 

posición deseada.

 4. Haga clic en  para guardar la posición. Cuando el indicador de la posición seleccionada se pone en 

verde, se ha fijado este punto preestablecido.

 5. Para eliminar un punto preestablecido, selecciónelo en la lista y haga clic en , se borrará la con-

figuración del punto preestablecido.

Recuperación de puntos preestablecidos

Siga estos pasos para recuperar un punto preestablecido.

 1. Haga clic en un canal de la cámara equipado con la función de panorámica/inclinación/zoom.
 2. Seleccione un número de punto preestablecido en Preset Point List (Lista de puntos preestablecidos).

 3. Haga clic en  para recuperar el punto preestablecido. La cámara seleccionada se moverá auto-

máticamente a la posición preestablecida.

Configuración de un recorrido de cámara de tipo cúpula

Con CMS los usuarios pueden establecer el recorrido. Siga estos pasos para definir recorridos.

 1. Haga clic en un canal de la cámara equipado con la función de panorámica/inclinación/zoom.
 2. Seleccione un número de recorrido en la Tour Path List (Lista de recorridos).

 3. Haga clic en  para comenzar a grabar el recorrido.

 4. Establezca un recorrido usando el Panel de control de dirección para girar/inclinar la cámara.

 5. Haga clic en  para guardar la posición. Cuando el indicador de la posición seleccionada se pone en 

verde, se ha establecido esta posición de recorrido.

28 / 93



Ejecución de un recorrido de cámara de tipo cúpula

Siga estos pasos para ejecutar el recorrido de cámara:

 1. Haga clic en un canal de la cámara en el que ya haya definido un recorrido de cámara.
 2. Seleccione un número de recorrido en Tour Path List (Lista de recorridos).

 3. Haga clic en  para iniciar el recorrido según lo grabado.

 4. Para finalizar el recorrido de la cámara, haga clic en Panel de control de dirección.

Ajustes de secuencia

La cámara admite un total de 8 líneas de secuencia; cada línea de secuencia consta de hasta 64 puntos prees-
tablecidos. Consulte las instrucciones que aparecen a continuación para programar una línea de secuencia.

AVISO! Antes de configurar esta función, los usuarios deben predefinir al menos dos puntos prees-
tablecidos.

Línea de secuencia

Haga clic en  y seleccione el número de línea de secuencia que desea establecer en la lista desplegable de 

la parte superior del menú Ajustes de secuencia.

Configuración de los puntos preestablecidos secuenciales

Configure cada punto preestablecido de la línea de secuencia programada en orden. Seleccione un punto 
preestablecido de la lista <Name> (Nombre) para el número especificado de punto preestablecido e intro-
duzca tanto el tiempo de permanencia (0 a 127) como la velocidad (0 a 14) en los campos correspondientes.

Cuando termine de configurar los puntos preestablecidos secuenciales, haga clic en <Apply> (Aplicar) para 
guardar la configuración.

Ejecución de la secuencia

Seleccione la línea de secuencia especificada en la lista desplegable y haga clic en  y, a continuación, la 

cámara comenzará a avanzar cada escena de forma secuencial según lo programado.

Para ver la cámara ejecutando una línea de secuencia en modo de pantalla completa, mueva el cursor al 
panel de vista en tiempo real, haga clic con el botón derecho y con el botón izquierdo para seleccionar "Full 
Screen" (Pantalla completa). A continuación, los usuarios pueden ver la navegación de la cámara en pantalla 
completa.

Para detener la ejecución de la línea de secuencia, solo tiene que mover el cursor al panel de vista en tiempo 
real y mover la cámara en cualquier dirección.

Vista en vivo
Control PTZ de la cámara
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Vista en vivo
Control PTZ de la cámara

Configuración de crucero

La cámara admite hasta 8 recorridos de crucero. Consulte los pasos que se indican a continuación para con-
figurar un recorrido de crucero.

 1. Seleccione un número de recorrido en la lista desplegable.

 2. Mueva el cursor al panel de vista en tiempo real y mueva la cámara a la vista que desee (controles PTZ) 
como punto de inicio de un recorrido de crucero.

 3. Haga clic en  para comenzar a grabar el recorrido de crucero.

 4. Establezca un recorrido de crucero usando el Panel de control de dirección para girar/inclinar la cámara.

 5. Haga clic en  para guardar la posición.  se vuelve verde , lo que sugiere que se ha 

establecido este recorrido.

 6. Haga clic en <Apply > (Aplicar) para guardar la configuración.

Ejecución de crucero

Seleccione el recorrido de crucero especificado en la lista desplegable, haga clic en  y, a continuación, la 

cámara comenzará a recorrerla según lo grabado.

Para ver la cámara haciendo el recorrido en modo de pantalla completa, mueva el cursor al panel de vista en 
tiempo real, haga clic con el botón derecho y con el botón izquierdo para seleccionar "Full Screen" (Pantalla 
completa). A continuación, los usuarios pueden ver la navegación de la cámara en pantalla completa.

Para detener la ejecución del Recorrido de crucero, solo tiene que mover el cursor al panel de vista en tiempo 
real y mover la cámara en cualquier dirección.

Ajustes de Auto Pan

La cámara admite 4 recorridos de Auto Pan. Siga los pasos para configurar un recorrido de Auto Pan.

 1. Seleccione un número de recorrido en la lista desplegable.

 2. Haga clic en  y seleccione el ratio de velocidad en la lista desplegable <Speed> (Velocidad); el ratio de 

velocidad oscila entre 0 (baja) y 3 (rápida).

 3. Seleccione ejecutar el Recorrido de Auto Pan en dirección derecha / izquierda en la lista desplegable 
<Direction> (Dirección).

 4. Mueva el cursor al panel de vista en tiempo real y mueva la cámara a la vista que desee como punto de 
inicio de un recorrido de Auto Pan.

 5. Mueva la cámara a otra posición como punto final del recorrido de Auto Pan.
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 6. Haga clic en  para guardar la posición.  se vuelve verde , lo que sugiere que se ha 

establecido este recorrido.

AVISO! El ratio de zoom del punto de inicio de un Auto Pan permanece igual en todo el recorrido.

 7. Cuando termine de configurar auto pan, haga clic en < Apply> (Aplicar) para guardar la configuración.

Ejecución de Auto Pan

Seleccione el recorrido de Auto Pan especificado en la lista desplegable, haga clic en el botón < > y, a con-
tinuación, la cámara comenzará a moverse horizontalmente según lo grabado.

Para ver la cámara girando en modo de pantalla completa, mueva el cursor al panel de vista en tiempo real, 
haga clic con el botón derecho y con el botón izquierdo para seleccionar "Full Screen" (Pantalla completa). A 
continuación, los usuarios pueden ver la navegación de la cámara en pantalla completa.

Para detener la ejecución del Recorrido de Auto Pan, solo tiene que mover el cursor al panel de vista en 
tiempo real y mover la cámara en cualquier dirección.

Ajustes de inicio

Se puede establecer un modo de funcionamiento para garantizar que se produzca una supervisión constante. 
Si la cámara funciona en reposo durante un período de tiempo, la función seleccionada se activará auto-
máticamente. La función Inicio permite hacer un seguimiento constante y preciso para evitar que la cámara 
se quede parada o pierda algún evento.

Interruptor

Seleccione <Activado> o <Desactivado> para activar o desactivar la función Inicio.

Hora

La hora aquí representa la duración del tiempo de inactividad de la cámara antes de ejecutar un punto prees-
tablecido / línea de crucero / recorrido de Auto Pan / línea de secuencia. Cuando se activa la función Inicio, la 
cámara iniciará una cuenta atrás cuando esté en reposo y, a continuación, ejecutará la acción predefinida 
cuando el tiempo expire. El período de tiempo oscila entre 1 min y 128 min.; especifíquelo en el campo.

Tipo y línea

Seleccione un tipo de acción de Inicio (Punto preestablecido / Línea de crucero / Recorrido de Auto Pan / 
Línea de secuencia) y especifique el número de Punto preestablecido / Línea de crucero / Recorrido de Auto 
Pan / Línea de secuencia en las listas desplegables <Type> (Tipo) y <Line> (Línea).

Haga clic en Apply (Aplicar) para guardar la configuración de Inicio.

Vista en vivo
Control PTZ de la cámara
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Vista en vivo
Control PTZ de la cámara

Ajustes del ángulo

El ángulo de inclinación de la cámara es ajustable desde un mínimo de −10° hasta un máximo de +100°.

Introduzca el ángulo de inclinación mínimo y máximo que desee en los campos correspondientes res-
pectivamente.

Haga clic en < Apply> (Aplicar) para guardar la configuración del ángulo.

Configuración de PTZ

Voltear

Los usuarios pueden realizar un seguimiento continuo de un objeto cuando pasa por debajo de la cámara 
con el ajuste del modo Flip to Mechanical (M.E.) (Voltear a mecánico).

AVISO! El ajuste Voltear solo se controla manualmente. Si una posición predefinida o un punto para otra 
función (p. ej., la secuencia) se establece en la posición que solo se puede alcanzar mediante el movimiento 
Voltear, cuando la función Voltear se desactiva, la posición ya no se puede alcanzar.

AVISO! Para que la cámara se incline entre un rango específico, como de -10° a +100°, vaya a la sección < 
Angle Setting > (Configuración del ángulo) para establecer el rango del ángulo de inclinación. De lo con-
trario, la cámara se inclinará 90° como predeterminado.

M.E. Modo

M.E. es una operación mecánica estándar. A medida que la cámara se inclina hasta el ángulo máximo, se gira 
180° y, a continuación, continúa inclinándose para seguir rastreando los objetos.

Velocidad con zoom

Esta función permite que la cámara ajuste la velocidad de giro/inclinación automáticamente mediante el algo-
ritmo interno cuando se cambia la relación de zoom. La velocidad de rotación será más lenta a medida que la 
relación de zoom aumente.

Haga clic en <Apply > (Aplicar) para guardar la configuración.

Calibración automática (Servo Feedback)

Al integrar la tecnología Servo Feedback, la cámara se calibra y vuelve con precisión a la posición anterior sin 
detenerse cuando se detecta la desviación del pivote de la cúpula.

Seleccione <On> (Activado) y haga clic en < Apply> (Aplicar) para guardar la configuración.
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Configuración de la máscara de privacidad

La función Privacy Mask (máscara de privacidad) tiene como objetivo evitar cualquier supervisión intrusiva. A 
la hora de configurar una máscara, se recomienda establecerla al menos dos veces más grande (alto y ancho) 
que el objeto enmascarado. La cámara aplicará el centro de la vista seleccionada como punto de partida. Por 
lo tanto, mantenga el objeto/región objetivo posicionado casi en el centro de la escena.

Color

Seleccione un color de la lista desplegable <Color> para la máscara de privacidad especificada. Haga clic en 
<Set > (Establecer) para aplicar la configuración.

Número de máscara (1~20): Especifique el número de la máscara de privacidad programada en el campo de 
entrada.

Factor de zoom

Normalmente, una máscara de privacidad se recoloca y cambia de tamaño para cubrir el área enmascarada 
siempre que la cámara esté panoramizada/inclinada/ampliada. Con el factor de zoom se puede ocultar la 
máscara cuando la relación de zoom es inferior a la relación original.

Por ejemplo, cuando la máscara de privacidad se establece con una relación de zoom determinada (p. ej., 5x), 
el tamaño de la máscara de privacidad se cambiará cuando la cámara se acerque (p. ej., de 5x a 20x). Sin 
embargo, cuando la cámara se aleja (p. ej., de 5x a 2x), la máscara de privacidad se ocultará.

Seleccione <Activado> o <Desactivado> para activar o desactivar la función Factor de zoom.

el ajuste.

Configuración de imagen de la cámara
Es posible configurar los valores de imagen de la cámara IP seleccionada. Dichos valores incluyen ajuste de 
imagen, reducción de ruido, balance de blancos, etc.

 1. Haga clic en el canal de la cámara IP deseada y comience la configuración. Mientras se ajusta la con-
figuración de imagen, compruebe la parrilla de canales para el cambio de la configuración de la imagen.

 2. Cuando termine, haga clic en Apply (Aplicar) para guardar la configuración.
 3. Si fuera necesario, haga clic en Refresh (Actualizar) para actualizar la configuración.

AVISO! Es posible que algunas funciones de configuración no estén disponibles en determinados modelos 
de cámaras IP. Los elementos de configuración aparecerán atenuados y no se podrá acceder a ellos.

Vista en vivo
Configuración de imagen de la cámara
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Vista en vivo
Formato de vídeo de la cámara

Formato de vídeo de la cámara
Los usuarios pueden configurar los ajustes del formato de vídeo. Los elementos de configuración varían 
según los tipos de cámaras IP, "MOBOTIX MOVE -H.265" y "MOBOTIX MOVE-H.264", ONVIF.

Los ajustes de formato de vídeo incluyen la resolución de vídeo, la rotación de vídeo, la configuración de la 
velocidad de bits, etc. Sin embargo, si la transmisión en tiempo real procede del NVR o de un codificador 
conectado, este panel de configuración no estará disponible.

 1. Después de llevar a cabo la configuración, haga clic en Apply (Aplicar). De lo contrario, la configuración 
no se guardará.

 2. Si fuera necesario, haga clic en Refresh (Actualizar) para actualizar la configuración.

AVISO! Es posible que algunos elementos de configuración no estén disponibles en determinados modelos 
de cámaras IP. Los elementos de configuración aparecerán atenuados y no se podrá acceder a ellos.

Configuración de la detección de movimiento de la 
cámara
Los usuarios pueden configurar la detección de movimiento. La configuración de detección de movimiento 
incluye índice de movimiento, muestreo, nivel de detección, sensibilidad, intervalo de tiempo y áreas detec-
ción de movimiento.

 n Haga clic en cualquier canal de cámara IP y seleccione Camera Motion Setup (Configuración de movi-
miento de la cámara) para acceder al modo de configuración de movimiento. Los elementos se des-
criben a continuación. 

AVISO! Tenga en cuenta que esta función no está disponible para cámaras IP conectadas a través de 
NVR o codificadores.

AVISO! Los usuarios deben asegurarse de que la función de detección de movimiento de CMS está activada 
en el menú Configuración de eventos. Consulte la sección Configuración de eventos en Configuración del 
sistema para obtener más instrucciones.

Motion Intensity (Intensidad de movimiento)

La intensidad de movimiento muestra el estado de actividad de movimiento.
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Motion Index (Índice de movimiento)

El CMS admite cuatro conjuntos de ajustes de detección de movimiento para las cámaras IP. Seleccione un 
conjunto en el menú desplegable junto a <Motion> (Movimiento). En cada índice de movimiento, puede esta-
blecer un máximo de diez conjuntos de ventanas de detección de movimiento.

Sampling (Muestreo)

Este elemento se utiliza para examinar las diferencias entre dos fotogramas. Los usuarios pueden configurar 
el intervalo del píxel de muestreo. Por ejemplo, si los usuarios establecen el intervalo como 5. El sistema de 
cámara IP tomará un píxel de muestreo de cada 5 píxeles de cada fila y cada columna en el área de detec-
ción. La alarma se activará cuando se detecten diferencias.

Detection Level (Nivel de detección)

Los usuarios pueden configurar el nivel de detección para cada píxel de muestreo. El nivel de detección es el 
grado en el que la cámara puede aceptar las diferencias entre dos píxeles de muestreo. Cuanto menor sea el 
valor, menor será el nivel de detección.

Sensibilidad

Este elemento se utiliza para configurar la sensibilidad de detección. Los valores más grandes indican una 
detección de movimiento más sensible.

Time Interval (Intervalo de tiempo)

Este elemento se utiliza para ajustar el intervalo de tiempo entre cada movimiento de detección.

Configuración de la región de detección

En el modo de configuración de movimiento, se muestra un marco rojo (ventana de detección) en la parrilla 
de canales. Tenga en cuenta que la cantidad de regiones de detección de movimiento puede variar según los 
modelos de cámaras IP. Consulte lo siguiente para configurar las ventanas de detección de movimiento.

 1. Haga clic en <Edit> (Editar) para cambiar el tamaño de la ventana de detección.

 2. Marque la casilla <Enable Brush> (Habilitar pincel), haga clic con el botón izquierdo del ratón y arrastre el 
cursor para dibujar la región de detección que desee.

 3. Haga clic en <Apply> (Aplicar) para guardar la configuración en el canal de la cámara IP seleccionado.

 4. Para eliminar una ventana de detección de movimiento añadida, desmarque la casilla <Enable Brush> 
(Habilitar pincel) para borrar la región de detección dibujada, haga clic con el botón izquierdo del ratón y 
arrastre el cursor sobre las cuadrículas de color.

 5. Haga clic en <Apply> (Aplicar) para guardar la configuración en el canal de la cámara IP seleccionado.

 6. Si fuera necesario, haga clic en <Refresh> (Actualizar) para cambiar la configuración.

Configuración de las ventanas de detección de movimiento

Consulte lo siguiente para configurar las ventanas de detección de movimiento.

Vista en vivo
Configuración de la detección de movimiento de la cámara
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Vista en vivo
Configuración de la detección de audio de la cámara

 1. Para cambiar la ubicación de la ventana de detección de movimiento, haga clic en el centro de la ventana 
de detección y muévala a la ubicación deseada.

 2. Para cambiar el tamaño de la ventana de detección, haga clic y arrastre el borde del marco rojo.
 3. Para añadir una nueva ventana de detección, haga clic con el botón derecho en la parrilla de canales y 

seleccione Add New Window (Añadir nueva ventana) en el menú desplegable.
 4. Haga clic en Apply (Aplicar) para guardar la configuración en el canal de la cámara IP seleccionado.

Eliminación de una ventana de detección de movimiento

 1. Seleccione la ventana de detección deseada y haga clic con el botón derecho del ratón en la parrilla de 
canales.

 2. Seleccione Remove Selected Window (Eliminar ventana seleccionada) en la lista desplegable. Se eli-
minará la ventana de detección que haya seleccionado. También puede seleccionar Remove All Window 
(Eliminar todas las ventanas) para eliminar todas las ventanas de detección.

 3. Haga clic en Apply (Aplicar) para guardar la configuración en el canal de la cámara IP seleccionado.
 4. Si fuera necesario, haga clic en Refresh (Actualizar) para actualizar la configuración.

Configuración de la detección de audio de la 
cámara
La función Detección de audio permite a la cámara detectar audio cuando el volumen de audio del área 
detectada alcanza o supera el valor del umbral de sensibilidad determinado.

AVISO! La función Detección de audio solo está disponible para modelos que cuenten con la función de E/S 
de audio.

En el ajuste Detección de audio, el ajuste predeterminado para la función Detección de audio es <Des-
activado>. Active la función seleccionando <Activado>.

En esta sección, los usuarios pueden ajustar distintos parámetros de Detección de audio.

Nivel de detección [1-100]: El elemento es para establecer el nivel de detección de cada volumen de mues-
treo; cuanto menor sea el valor, más sensible será. El valor predeterminado es 10.

Intervalo de tiempo (s) [0-7200]: El valor es el intervalo entre cada audio detectado. El valor pre-
determinado es 10.

Tras la configuración, haga clic en < >. De lo contrario, la configuración no se guardará. Si fuera necesario, 
haga clic en < > para cambiar la configuración.
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Configuración de la programación de la cámara
Esta función permite a los usuarios configurar horarios para funciones como: <Interruptor de alarma>, <Detec-
ción de movimiento> y <Detección de fallos de red>. La función admite hasta 10 conjuntos de intervalos de 
tiempo en la lista de intervalos de tiempo.

 1. Seleccione un intervalo de tiempo en la lista de intervalos de tiempo.

 2. Marque las casillas de los días de la semana para seleccionar los días específicos de la semana.

 3. Seleccione un modo de tiempo: Día, Noche u Hora. En el modo Hora, especifique la hora de inicio (hora:-
minuto) y la duración (hora:minuto) para activar las funciones activadas por el programa. El intervalo de 
ajuste de la duración es de 00:00 a 168:59.

 4. Haga clic en <Guardar> para guardar el ajuste. También puede hacer clic en <Borrar> para eliminar un 
intervalo de tiempo seleccionado.

Modo de tiempo

Día: El perfil de la cámara se cargará cuando el filtro de corte de IR esté activado.

Noche: El perfil de la cámara se cargará cuando el filtro de corte de IR esté desactivado.

Hora: Indica la hora de inicio y la duración del programa.

AVISO! DEBE seleccionar <Por programa> en cada página de configuración de características para activar la 
función de programación.

Configuración del análisis de vídeo de la cámara
CMS permite conectar y configurar cámaras IP que implementen la función de análisis de vídeo (VA).

A continuación se describe cómo configurar la función de análisis de vídeo. Para obtener más información, 
consulte el Manual de análisis de vídeo.

Vista en vivo
Configuración de la programación de la cámara
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Vista en vivo
Configuración del análisis de vídeo de la cámara

Fig. 8: Configuración del análisis de vídeo de la cámara

Análisis de vídeo

Puede configurar e implementar dos conjuntos de análisis de vídeo simultáneamente. Seleccione <1> o <2> 
en el menú desplegable del Análisis de vídeo.

 1. Seleccione On (Activado) en el menú desplegable Activar para la activación.
 2. Seleccione un análisis de vídeo en el menú desplegable Comportamiento seleccionado. Las opciones son 

las siguientes: <Object Abandoned> (Objeto abandonado), <Intrusion Detection> (Detección de intru-
siones), <Camera Sabotage> (Sabotaje de cámara), <Wrong Direction> (Dirección equivocada), <Loitering 
Detection> (Detección de merodeo), <Object Counting> (Recuento de objetos), <Object Removal> (Remo-
ción de objetos) y <Stopped Vehicle> (Vehículo detenido).

 3. Complete la configuración de comportamiento. Los elementos de configuración de zona varían según el 
comportamiento de análisis que se esté configurando.

Configuración de zona

Algunos comportamientos de análisis requieren la configuración de una zona. La configuración de zona per-
mite a los usuarios supervisar y comprobar si hay intrusión, objetos extraviados o eliminados de ciertas áreas.

 1. en la parrilla de canales, haga clic con el botón derecho para mostrar el menú de configuración. El menú 
de configuración enumerará todos los elementos de configuración de zona.

 2. Complete todos los elementos de configuración y haga clic en Apply (Aplicar).
 3. asigne un nombre a la zona de detección.
 4. defina la dirección de movimiento que debe seguir la cámara. La alarma solo se activará si la cámara 

detecta movimiento en la dirección específica.
 5. Configure el número de objetos que activan la alarma. La alarma se activará cuando el número de obje-

tos contados alcance el valor indicado.
 6. Dwell time (Tiempo de permanencia): defina la cantidad de tiempo que una alarma permanece tras acti-

varse. El tiempo de permanencia puede variar entre 1 y 1000 segundos.
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 7. Delay before alarm (Retraso antes de la alarma): defina la cantidad de tiempo que debe durar el com-
portamiento definido para que se active la alarma. El intervalo de tiempo oscila entre 20 y 1800 segun-
dos.

 8. Reset counter on alarm (Restablecer contador de alarma): active o desactive esta opción para restablecer 
o mantener el recuento de objetos.

 9. Cuando termine, haga clic en Apply (Aplicar) para guardar la configuración y aplicarla.
 10. Vaya a Setup > System > Event Management (Configuración > Sistema > Gestión de eventos) para com-

pletar la configuración de notificación de eventos VA. Consulte la sección Gestión de eventos en Con-
figuración del sistema para obtener más detalles.

"Face Detection" (Detección facial)

La función "Face Detection" (Detección facial) permite usar estrategias de marketing dirigido basadas en la 
segmentación demográfica. Esta función identifica el género de los visitantes, su temperatura y su franja de 
edad aproximada mediante la detección y el análisis de los rostros. La información proporcionada se puede 
emplear en el marketing dirigida y la evaluación de campañas.

Configuración de comportamiento

Algunos comportamientos de análisis requieren la configuración de una zona. La configuración de zona per-
mite a los usuarios supervisar y comprobar si hay intrusión, objetos extraviados o eliminados de ciertas áreas. 
Tenga en cuenta que los elementos de la configuración de comportamiento varían en función del com-
portamiento de análisis que se esté configurando.

Configuración de zona
en la parrilla de canales, haga clic con el botón derecho para mostrar el menú de configuración. El menú de 
configuración enumerará todos los elementos de configuración de zona.

 Nombre: asigne un nombre a la zona de detección.

Directions (Dirección): defina la dirección de movimiento que debe seguir la cámara. La alarma solo se acti-
vará si la cámara detecta movimiento en la dirección específica.

Alarm at (Alarma ante): configure la cantidad de objetos que activan la alarma. La alarma se activará 
cuando el número de objetos contados alcance el valor indicado.

Dwell Time (Tiempo de permanencia): defina la cantidad de tiempo que una alarma permanece tras acti-
varse. El tiempo de permanencia puede variar entre 1 y 1000 segundos.

Delay before alarm (Retraso antes de la alarma): defina la cantidad de tiempo que debe durar el com-
portamiento definido para que se active la alarma. El intervalo de tiempo oscila entre 20 y 1800 segundos.

Vista en vivo
Configuración del análisis de vídeo de la cámara
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Vista en vivo
Configuración de la corrección del ojo de pez de la cámara

Sensibilidad: Este elemento se utiliza para configurar la sensibilidad de detección. Los valores más grandes 
indican una detección de movimiento más sensible.

 Reset counter on alarm (Restablecer contador de alarma): active o desactive esta opción para restablecer 
o mantener el recuento de objetos.

 1. Cuando termine, haga clic en < > para guardar la configuración y aplicarla.

 2. Vaya a Setup/System/Event Management (Configuración/Sistema/Gestión de eventos) para completar 
la configuración de notificación de eventos VA. Consulte la sección Gestión de eventos en Configuración 
del sistema para obtener más detalles.

Configuración de la corrección del ojo de pez de la 
cámara
CMS está equipado con la función de corrección de la cámara ojo de pez, lo que permite a los usuarios ver las 
ubicaciones de monitorización con detalles precisos. Se proporcionan dos tipos de corrección (frontal y pos-
terior) en función de si la cámara ojo de pez dispone o no de la función de corrección. Haga doble clic en la 
parrilla de canales de la cámara ojo de pez para mostrarla en el modo de un solo canal y, a continuación, 
haga clic en <Camera Fisheye Setup> (Configuración de ojo de pez de la cámara) para ver los elementos de 
ajuste.

Tipo de corrección de ojo de pez

 n Frontal: Este tipo de corrección está especialmente destinado para cámaras de ojo de pez que ya están 
equipadas con la función de corrección.

 n Posterior: El segundo tipo de corrección <back> (posterior) está diseñado para cámaras de ojo de pez 
que no están equipadas con la función de corrección y CMS corregirá las imágenes de origen de ojo de 
pez y proporciona varios modos de corrección para que los usuarios puedan elegir.

 1. Seleccione Front (Frontal) o Back (Posterior) y elija un método de instalación en Installation (Ins-
talación) según el tipo de montaje de la cámara.

 2. Haga clic en Apply (Aplicar). La cámara ojo de pez corregirá sus imágenes de origen.

 3. Mueva el cursor del ratón a la esquina inferior derecha de la parrilla de canales y haga clic en  para 

mostrar la lista Ajuste de imagen de ojo de pez. Los módulos de corrección son los siguientes: <Normal 
View> (Vista normal), <PTZ View> (Vista PTZ), <360 View> (Vista en 360), <Quad View> (Vista cuádruple), 
<OPR View> (Vista OPR) y <1O3R View> (Vista 1O3R).
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 4. Seleccione un modo preferido y CMS se detendrán automáticamente las imágenes de origen de ojo de 
pez. A continuación, se describen los modos de corrección que aparecen en la lista Ajuste de imagen de 
ojo de pez. 

El tipo de corrección <back> (posterior) se puede aplicar a ambos modelos de ojo de pez equipados o 
no con la función de corrección.

 5. Si fuera necesario, haga clic en Refresh (Actualizar) para actualizar la configuración.

Vista normal

Fig. 9: Vista normal de la configuración de la corrección del ojo de pez de la cámara

 1. Seleccione  para ver los vídeos en tiempo real sin corregir.

 2. Desplace o incline virtualmente la cámara haciendo clic y arrastrando el ratón a cualquier dirección en 
<PTZ View> (Vista PTZ), <360 Panoramic> (Panorámica de 360) y <Quad View> (Vista cuádruple).

Vista PTZ

Fig. 10: Vista PTZ de configuración de la corrección del ojo de pez de la cámara

Vista en vivo
Configuración de la corrección del ojo de pez de la cámara
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Vista en vivo
Configuración de la corrección del ojo de pez de la cámara

 1. Seleccione  para ver las imágenes en tiempo real con corrección esférica.

360 View (Vista 360)

Fig. 11: Vista 360 de la configuración de la corrección del ojo de pez de la cámara

 1. Seleccione  para ver las imágenes en tiempo real con corrección esférica como dos vistas de 180°.

Vista cuádruple

Fig. 12: Vista cuádruple del ojo de pez de la cámara

 1. Seleccione  para ver las imágenes en tiempo real con corrección esférica como cuatro vistas PTZ.
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OPR (una vista Original, una vista Panorámica y una vista Regional)

Fig. 13: Vista OPR de configuración de la corrección del ojo de pez de la cámara

El modo de visualización OPR  permite a los usuarios comprobar la vista en tiempo real con corrección 

esférica en una pantalla de 180° con una vista regional. Mientras tanto, los usuarios pueden comprobar la ubi-
cación correspondiente de cualquiera de las dos vistas con la vista original.

Los usuarios pueden implementar la función ePTZ tanto en vista panorámica como regional.

 1. Haga clic en cualquier parrilla de visualización.
 2. Haga clic y arrastre el cursor del ratón para cambiar la ubicación de la vista. También puede hacer clic en 

cualquiera de las parrillas de visualización.
 3. Haga clic y arrastre el marco azul transparente sobre la parrilla de visualización original.

1O3R (una vista Original y tres vistas Regionales)

Fig. 14: 1O3R (una vista Original y tres vistas Regionales)

El modo de visualización 1O3R  permite a los usuarios acceder a varias áreas de la cámara.

Vista en vivo
Configuración de la corrección del ojo de pez de la cámara
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Vista en vivo
Configuración de una máscara de cámara

Los usuarios pueden implementar la función ePTZ en cualquier vista regional para comprobar las áreas de 
supervisión.

 1. Haga clic en cualquier parrilla de visualización.
 2. Haga clic y arrastre el cursor del ratón para cambiar la ubicación de la vista regional. También puede 

hacer clic y arrastrar la ventana de vista previa en la cuadrícula de visualización original.

Configuración de una máscara de cámara

Añadir una máscara

Si marca la casilla de verificación Máscara de vídeo, aparecerá un marco rojo en el panel de vídeo en tiempo 
real. Utilice el ratón para arrastrar y soltar a fin de ajustar el tamaño de la máscara y colocarlo en la zona 
objetivo. Se puede establecer un máximo de 5 máscaras de vídeo.

AVISO! Se aconseja definir la máscara de vídeo un poco más grande que el objeto.

Cancelar una máscara

Desmarque la casilla de verificación Máscara de vídeo para eliminarla; la máscara desaparecerá del panel de 
vídeo en tiempo real de forma instantánea.

Configuración del color de máscara

Las opciones del color de la máscara incluyen negro, blanco, amarillo, rojo, verde, azul, cian y magenta. Haga 
clic en <Guardar> para confirmar la configuración.

Cuando termine la configuración, los usuarios deben hacer clic en < >. De lo contrario, la configuración no se 
guardará. Si fuera necesario, haga clic en < > para cambiar la configuración.

3.1.18 Configuración de superposición de texto de cámara

Los usuarios pueden seleccionar los elementos para mostrar los datos, incluidos la fecha y hora, la cadena de 
texto o los subtítulos en el panel de vídeo en tiempo real.

Tipo de superposición

Los usuarios pueden seleccionar hasta tres elementos de entre las cuatro opciones (incluidos la fecha y hora, 
la cadena de texto o los subtítulos) en el panel de vídeo en tiempo real.

Incluir fecha y hora

Marque la casilla para habilitar la visualización de la fecha y la hora en el panel de vídeo en tiempo real y apa-
recerá una ventana de superposición de texto en vídeo. Mueva el cursor del ratón hacia el centro de la ven-
tana y luego haga clic y arrastre la ventana hasta la posición de visualización preferida. Los usuarios pueden 
elegir mostrar la fecha, la hora o la fecha y hora en el menú desplegable y decidir la posición de alineación de 
cadena (izquierda / derecha).

Incluir cadena de texto
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Marque la casilla para habilitar la visualización de la cadena de texto en el panel de vídeo en tiempo real y 
aparecerá una ventana de superposición de texto en vídeo. Mueva el cursor del ratón hacia el centro de la 
ventana y luego haga clic y arrastre la ventana hasta la posición de visualización preferida. Escriba el texto 
que desea mostrar en el campo de entrada y decida la posición de alineación de cadena (izquierda / dere-
cha). La longitud máxima de la cadena de texto es de 15 caracteres alfanuméricos.

Incluir subtítulo

Marque la casilla para habilitar la visualización del subtítulo en el panel de vídeo en tiempo real y aparecerá 
una ventana de superposición de texto en vídeo. Mueva el cursor del ratón hacia el centro de la ventana y 
luego haga clic y arrastre la ventana hasta la posición de visualización preferida. Escriba el texto que desea 
mostrar en el campo de entrada y decida la posición de alineación de cadena (izquierda / derecha). Los usua-
rios pueden configurar hasta 5 subtítulos, y la longitud máxima de cada uno de ellos es de 16 caracteres alfa-
numéricos.

Ajuste de superposición de texto

Los usuarios pueden elegir el color de la superposición de texto (negro, blanco, amarillo, rojo, verde, azul, 
cian o magenta) y el tamaño de la superposición de texto (pequeño, mediano o grande) de visualización de la 
fecha y hora / la cadena de texto / el subtítulo.

Cuando termine la configuración, los usuarios deben hacer clic en < >. De lo contrario, la configuración no se 
guardará. Si fuera necesario, haga clic en < > para cambiar la configuración.

3.1.19 Configuración de la alarma de cámara

La cámara admite una entrada de alarma y una salida de relé para la cooperación con el sistema de alarma 
para capturar imágenes de eventos. Consulte la definición de PIN de alarma que aparece a continuación para 
conectar dispositivos de alarma a la cámara si es necesario.

Interruptor de alarma

El ajuste predeterminado de la función Interruptor de alarma es <Desactivado>. Active la función selec-
cionando <Activado>.

Tipo de alarma

Seleccione un tipo de alarma, <Cierre normal> o <Apertura normal>, que corresponda a la aplicación de 
alarma.

Cuando termine la configuración, los usuarios deben hacer clic en < >. De lo contrario, la configuración no se 
guardará. Si fuera necesario, haga clic en < > para cambiar la configuración.

Configuración de superposición de texto de cámara
Los usuarios pueden seleccionar los elementos para mostrar los datos, incluidos la fecha y hora, la cadena de 
texto o los subtítulos en el panel de vídeo en tiempo real.

Vista en vivo
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45 / 93



Vista en vivo
Configuración de superposición de texto de cámara

Tipo de superposición: Los usuarios pueden seleccionar hasta tres elementos de entre las cuatro opciones 
(incluidos la fecha y hora, la cadena de texto o los subtítulos) en el panel de vídeo en tiempo real.

Incluir fecha y hora: Marque la casilla para habilitar la visualización de la fecha y la hora en el panel de vídeo 
en tiempo real y aparecerá una ventana de superposición de texto en vídeo. Mueva el cursor del ratón hacia 
el centro de la ventana y luego haga clic y arrastre la ventana hasta la posición de visualización preferida. Los 
usuarios pueden elegir mostrar la fecha, la hora o la fecha y hora en el menú desplegable y decidir la posición 
de alineación de cadena (izquierda / derecha).

Incluir cadena de texto: Marque la casilla para habilitar la visualización de la cadena de texto en el panel de 
vídeo en tiempo real y aparecerá una ventana de superposición de texto en vídeo. Mueva el cursor del ratón 
hacia el centro de la ventana y luego haga clic y arrastre la ventana hasta la posición de visualización pre-
ferida. Escriba el texto que desea mostrar en el campo de entrada y decida la posición de alineación de 
cadena (izquierda / derecha). La longitud máxima de la cadena de texto es de 15 caracteres alfanuméricos.

Incluir subtítulo: Marque la casilla para habilitar la visualización del subtítulo en el panel de vídeo en tiempo 
real y aparecerá una ventana de superposición de texto en vídeo. Mueva el cursor del ratón hacia el centro de 
la ventana y luego haga clic y arrastre la ventana hasta la posición de visualización preferida. Escriba el texto 
que desea mostrar en el campo de entrada y decida la posición de alineación de cadena (izquierda / dere-
cha). Los usuarios pueden configurar hasta 5 subtítulos, y la longitud máxima de cada uno de ellos es de 
16 caracteres alfanuméricos.

Ajuste de superposición de texto: Los usuarios pueden elegir el color de la superposición de texto (negro, 
blanco, amarillo, rojo, verde, azul, cian o magenta) y el tamaño de la superposición de texto (pequeño, 
mediano o grande) de visualización de la fecha y hora / la cadena de texto / el subtítulo.

Cuando termine la configuración, los usuarios deben hacer clic en < >. De lo contrario, la configuración no se 
guardará. Si fuera necesario, haga clic en < > para cambiar la configuración.

3.1.19 Configuración de la alarma de cámara

La cámara admite una entrada de alarma y una salida de relé para la cooperación con el sistema de alarma 
para capturar imágenes de eventos. Consulte la definición de PIN de alarma que aparece a continuación para 
conectar dispositivos de alarma a la cámara si es necesario.

Interruptor de alarma

El ajuste predeterminado de la función Interruptor de alarma es <Desactivado>. Active la función selec-
cionando <Activado>.

Tipo de alarma

Seleccione un tipo de alarma, <Cierre normal> o <Apertura normal>, que corresponda a la aplicación de 
alarma.

Cuando termine la configuración, los usuarios deben hacer clic en < >. De lo contrario, la configuración no se 
guardará. Si fuera necesario, haga clic en < > para cambiar la configuración.
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Configuración de la alarma de la cámara
La cámara admite una entrada de alarma y una salida de relé para la cooperación con el sistema de alarma 
para capturar imágenes de eventos. Consulte la definición de PIN de alarma que aparece a continuación para 
conectar dispositivos de alarma a la cámara si es necesario.

Interruptor de alarma: El ajuste predeterminado de la función Interruptor de alarma es <Desactivado>. 
Active la función seleccionando <Activado>.

Tipo de alarma: Seleccione un tipo de alarma, <Cierre normal> o <Apertura normal>, que corresponda a la 
aplicación de alarma.

Cuando termine la configuración, los usuarios deben hacer clic en < >. De lo contrario, la configuración no se 
guardará. Si fuera necesario, haga clic en < > para cambiar la configuración.

Configuración de IR/exposición de la cámara
Configure aquí la función IR y la configuración de la exposición de las cámaras IP. Sin embargo, si la trans-
misión en tiempo real procede del codificador conectado, este panel de configuración no estará disponible.

Configuración de exposición

La exposición es la cantidad de luz que recibe el sensor de imagen. Viene determinada por la amplitud de la 
apertura del diafragma del objetivo, la velocidad del obturador y otros parámetros de exposición.

 1. Elija un modo de exposición adecuado para la cámara seleccionada en la lista desplegable Exposure 
Mode (Modo de exposición). Tenga en cuenta que las opciones de los modos de exposición se pro-
porcionan de forma diferente según los distintos modelos de cámaras IP.

 2. Configure sus parámetros relevantes, tales como la velocidad del obturador y la ganancia máxima. Con-
sulte los manuales de la cámara IP para obtener más información sobre la configuración de los pará-
metros de exposición.

 3. Haga clic en Apply (Aplicar) para guardar la configuración en el canal de la cámara IP seleccionado.
 4. Si fuera necesario, haga clic en Refresh (Actualizar) para actualizar la configuración.

Configuración de la función IR

La función IR permite/evita que la luz infrarroja (IR) llegue al sensor de imagen.

 n IR Mode (Modo IR): Define la acción del filtro de corte de IR. Consulte a continuación las descripciones 
de cada opción y seleccione el modo adecuado.

 n Auto (Automático): Seleccione este modo; la cámara decidirá cuándo eliminar el filtro de corte de IR.
 n Manual On (Manual activado): Utilice este modo cuando el nivel de luz ambiental sea bajo. El filtro de 

corte de IR se eliminará para generar imágenes claras en blanco y negro.

Vista en vivo
Configuración de la alarma de la cámara
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Vista en vivo
Configuración del sistema de la cámara

 n Manual Off (Manual desactivado): Seleccione este modo para usar el filtro de corte de IR. El filtro de 
corte de IR puede filtrar la luz IR y permitir que la cámara genere imágenes de alta calidad en color.

 n Smart (Inteligente): El modo inteligente permite que la cámara decida cuándo eliminar el filtro de corte 
de IR. El mecanismo del modo inteligente evalúa si la fuente de luz principal proviene de una ilu-
minación IR. Si la fuente de luz principal procede de la iluminación IR, el filtro de corte de IR se man-
tendrá abierto (es decir, modo monocromo/nocturno).

Para cámaras con módulo LED de IR incorporado, hay tres modos de función IR adicionales disponibles: Light 
Sensor / Light On / Light Off (Sensor de luz / Luz activada / Luz desactivada).

 n Light Sensor (Sensor de luz): El sensor de luz detecta si hay luz ambiental para la función de cambio de 
día/noche. Las luces LED de IR se encenderán/apagarán mediante el sensor de luz.

 n Light On (Luz activada): En este modo, las luces LED de IR siempre estarán encendidas.
 n Light Off (Luz desactivada): En este modo, las luces LED de IR siempre estarán apagadas.

IR Day/Night Threshold (Umbral IR de día/noche)

IR Day/Night Threshold (Umbral IR de día/noche) se utilizar para configurar cuándo debe pasar la cámara del 
modo diurno al modo nocturno, o viceversa. La cámara detectará el brillo del entorno y el valor del umbral 
representa el nivel de la luz. Una vez que la cámara detecta que el nivel de luz alcanza el umbral establecido, 
cambiará automáticamente al modo diurno/nocturno. El intervalo del nivel es de 0 a 10, (más oscuro = 0; más 
brillante = 10).

 n IR Day Threshold (Umbral IR de día): Cuanto mayor sea el valor, más pronto pasará la cámara al modo 
diurno. El valor predeterminado es 7.

 n IR Night Threshold (Umbral IR de noche): Cuanto mayor sea el valor, más pronto pasará la cámara al 
modo nocturno. El valor predeterminado es 3.

 1. Haga clic en Apply (Aplicar) para guardar la configuración en el canal de la cámara IP seleccionado.

Configuración del sistema de la cámara
Los usuarios pueden seguir las instrucciones de esta página para restablecer la cámara a la configuración pre-
determinada de fábrica si es necesario.

Reiniciar: Haga clic en < > y el sistema de la cámara se reiniciará sin cambiar la configuración actual. Actua-
lice la página del navegador después de reiniciar el sistema de la cámara.

Restauración parcial: Haga clic en < > para recuperar la configuración predeterminada de fábrica (salvo con-
figuración de red). El sistema de la cámara se reiniciará en 30 segundos. Actualice la página del navegador 
después de reiniciar el sistema de la cámara.

AVISO! La dirección IP no se restaurará a los valores predeterminados.
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Información de la cámara
Es posible obtener un breve resumen de las cámaras IP conectadas. Haga clic en cualquier canal de cámara 
IP desde la ventana de vistas o desde el panel View Management (Gestión de vistas); la información básica de 
la cámara IP, como el nombre del sitio, la dirección IP, el tipo de dispositivo y el formato de vídeo, aparecerá 
en el panel Camera Information (Información de la cámara).

Vista en vivo
Información de la cámara
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Configuración general de CMS
En la pestaña de función Setup (Configuración), puede definir los ajustes básicos de CMS, 
como el idioma, la configuración de fecha/hora y red, la gestión de cuentas de usuario, etc.

Esta sección contiene la siguiente información:

Configuración de idioma 52

Configuración general 52

Sistema 54

Configuración de red 59

Configuración de gestión de usuarios 60

Configuración de gestión de PoE 62

 1. Haga clic en Setup (Configuración) para acceder a los menús de configuración general 
de CMS.

4



Configuración general de CMS
Configuración de idioma

Configuración de idioma

Fig. 15: Configuración de idioma

 1. En la pestaña de función Setup (Configuración), seleccione Language (Idioma) para acceder al menú de 
configuración de idioma.

 2. Seleccione el idioma que desee en la lista desplegable de idiomas y CMS cambiará automáticamente la 
configuración.

Configuración general
Seleccione General para acceder al menú básico de configuración de CMS.

Fig. 16: Configuración general
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Por Defecto

 1. Haga clic en Set (Establecer) para cargar la configuración predeterminada de CMS. CMS se cerrará des-
pués de cargar la configuración predeterminada.

Import/Export Configuration (Importar/Exportar configuración)

Import Configuration (Importar configuración)

Este elemento se utiliza para cargar un archivo de configuración CMS que se almacenó anteriormente en una 
unidad externa.

 1. Haga clic en Import (Importar) y seleccione el archivo que desea importar. 

 2. Haga clic en Confirm (Confirmar) para empezar a importar la configuración. Aparecerá un cuadro de diá-
logo de advertencia, notificando a los usuarios que el sistema CMS se cerrará inmediatamente.

Export Configuration (Exportar configuración)

Este elemento permite a los usuarios guardar y exportar la configuración actual de CMS. El formato de 
archivo exportado será *.zip.

AVISO! 
Se recomienda exportar los ajustes de configuración antes de actualizar el sistema CMS. Además, se reco-
mienda realizar una copia de seguridad de la configuración de forma rutinaria, por si se produjeran pro-
blemas inesperados.

Configuración general de CMS
Configuración general
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Configuración general de CMS
Sistema

 1. Haga clic en Export (Exportar) y aparecerá el cuadro de diálogo Save File (Guardar archivo).
 2. Designe un destino de archivo y haga clic en Choose (Elegir). Aparecerá un cuadro de diálogo de infor-

mación tal y como se indica a continuación. 

 3. Haga clic en Confirm (Confirmar) para iniciar la exportación. Cuando esto ha finalizado, aparece una ven-
tana de mensaje.

 4. Haga clic en OK para salir.
 5. Haga clic en Close (Cerrar) para cerrar la ventana de información.

Decodificación del software

Si la GPU del PC no es una tarjeta gráfica Intel, puede producirse un error mientras se ejecuta CMS. Por lo 
tanto, se recomienda encarecidamente activar Software Decode (Descodificación del software) para garan-
tizar que CMS se puede ejecutar sin problemas. Tenga en cuenta que la activación de la función Software 
Decode (Descodificación del software) puede aumentar la carga en la CPU cuando se conectan varios dis-
positivos IP a CMS.

 1. Active Software Decode (Descodificación del software).

Sistema
En el menú Sistema, los usuarios pueden configurar los ajustes del sistema NVR, como la fecha/hora, la red, 
la gestión de cuentas de usuario, la gestión de PoE, etc. Consulte los siguientes apartados para obtener infor-
mación más detallada de cada función.

Joysticks

AVISO! 
Utilice joysticks compatibles con Xinput para configurar la función.
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El CMS permite a los usuarios controlar cámaras PTZ o cámaras tipo cúpula de alta velocidad mediante un 
joystick USB. Siga los pasos que se indican a continuación para ajustar la configuración del joystick. El joys-
tick debe estar conectado al equipo ANTES de que se inicie el CMS.

Fig. 17: Configuración del joystick

 1. Seleccione <1> en el menú desplegable Joysticks Select (Selección de joystick).
 2. Haga clic en Change (Cambiar) desde cualquier función PTZ.
 3. Pulse cualquier botón del joystick para asignar la función.
 4. Haga clic en Apply (Aplicar) para guardar y activar la configuración.
 5. Vuelva a <Live View> (Vista en tiempo real) y seleccione cualquier canal de cámara PTZ/cúpula de alta 

velocidad. Pulse cualquier botón del joystick para controlar la función PTZ. Los usuarios también pueden 
girar el joystick hacia la derecha o la izquierda para girar la cámara y hacia arriba o hacia abajo para incli-
narla.

Desactivar joysticks

 1. Para desactivar la función del joystick, seleccione Unused (No utilizado) en los joysticks.
 2. Seleccione el menú desplegable y haga clic en Apply (Aplicar) para guardar la configuración.

Configuración general de CMS
Sistema
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Configuración general de CMS
Sistema

Monitor del sistema

Fig. 18: Configuración de Eventos

Los usuarios pueden establecer si se muestra la pantalla completa del canal activador de eventos. Acti-
ve/desactive la casilla y haga clic en Apply (Aplicar) para activar o desactivar esta función.

Acción de evento del sistema

Esta función permite configurar el umbral para el examen del sistema, por ejemplo, temperatura de la CPU, 
velocidad del ventilador, etc. Si el valor del sistema supera al umbral establecido, el NVR enviará un correo 
electrónico o alarmas para avisar del problema.

 n CPU Temperature Warning (Advertencia de temperatura de la CPU)
Si la temperatura de la CPU es demasiado alta, se pueden provocar fallos en el sistema. Rellene el 
valor de umbral de la temperatura de la CPU en el espacio en blanco; el valor predeterminado es 80 °C. 
Marque la casilla "Send E-mail" (Enviar correo electrónico) para recibir mensajes de advertencia 
cuando la temperatura de la CPU supere el umbral de temperatura.

 n Fan Speed Warning (Advertencia de velocidad del ventilador)
Si la velocidad del ventilador es demasiado alta, se pueden provocar fallos en el sistema. Rellene el 
valor de umbral de la velocidad del ventilador en el espacio en blanco; el valor predeterminado es 
200 rpm. Marque la casilla "Send E-mail" (Enviar correo electrónico) para recibir mensajes de adver-
tencia cuando la velocidad del ventilador supere la velocidad límite.

 n Hard Disk Warning (Advertencia del disco duro)
Se pueden recibir avisos de advertencia si el disco duro tiene errores inesperados o la velocidad de lec-
tura/escritura es demasiado lenta. Marque la casilla "Send E-mail" (Enviar correo electrónico) para reci-
bir mensajes de advertencia cuando el disco duro experimente errores inesperados.
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Configuración de Eventos

Los usuarios pueden establecer ajustes de eventos para cada cámara IP conectada. Acceda al menú Ajustes 
de evento a través de Setup (Configuración) > System (Sistema) > Event Management (Gestión de eventos).

Fig. 19: Configuración de eventos

Configuración predeterminada

La Configuración predeterminada permite a los usuarios configurar las acciones de eventos predeterminadas 
y aplicarlas a cualquier sitio de la cámara.

 1. Marque la casilla "Event Trigger" (Activador de eventos) para habilitar esta función.
 2. Defina las acciones del evento.
 3. Haga clic en Apply (Aplicar) para guardar y aplicar los ajustes.

 4. Seleccione cualquier sitio en Host local y haga clic en Default (Predeterminado). El sitio aplicará los ajus-
tes configurados anteriormente de Configuración predeterminada.

Acción de evento
Event Trigger (Activador de eventos)

 1. Active la casilla para activar la función Event Trigger (Activador de eventos).

Snapshot Options (Opciones de instantánea)

Esta función sirve para tomar una instantánea de la imagen del evento en tiempo real una vez que se activa 
un evento.

 1. Active la casilla, seleccione la resolución de la instantánea en el menú desplegable y haga clic en Apply 
(Aplicar) para guardar la configuración.

 2. Vaya a Playback/Export (Reproducción/exportación) > Snapshot By Event (Instantánea por evento) para 
ver las imágenes capturadas de los eventos.

Configuración general de CMS
Sistema
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Configuración general de CMS
Sistema

Send Email (Enviar correo electrónico)

Cuando está activado, CMS envía una notificación de evento a la dirección de correo electrónico configurada 
previamente en Network (Red).

 1. Active la casilla y haga clic en Apply (Aplicar) para guardar la configuración.

Host local

Los usuarios pueden establecer ajustes de eventos para cada cámara IP.

 1. Seleccione un sitio de cámara en la lista <Local Host> (Host local).
 2. Marque la casilla "Event Trigger" (Activador de eventos) para habilitar esta función.
 3. Seleccione el tipo de evento (Motion "Movimiento", Video Loss "Pérdida de vídeo", Video Analysis "Aná-

lisis de vídeo") en la lista desplegable.
 4. Defina las acciones del evento.
 5. Haga clic en Apply (Aplicar) para guardar y aplicar los ajustes.

Como alternativa, los usuarios pueden copiar y aplicar la configuración de un sitio a otros sitios.

 1. Seleccione cualquier sitio de cámara configurado en Local Host (Host local).
 2. Haga clic en Copy (Copiar).
 3. Active cualquier sitio de cámara desde la ventana emergente y, a continuación, haga clic en OK.

Configuración de eventos del NVR

La Configuración de eventos del NVR permite activar o desactivar la notificación de eventos del NVR en CMS.

Siga estos pasos para configurar la activación de eventos en un NVR.
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 1. Seleccione la IP del NVR y active la casilla Event Trigger (Disparador de eventos).
 2. Paso 2. Haga clic en Apply (Aplicar) para guardar y aplicar los ajustes.

Cuando se activa un evento del NVR, aparece el icono de eventos correspondiente en la parte inferior 

izquierda de la parrilla de canales y el mensaje de alerta se muestra en el centro de notificaciones  de 

CMS.

Configuración de red
El menú Network (Red) sirve para especificar el correo electrónico para recibir avisos de eventos/alarmas.

Fig. 20: Configuración de red

Configuración general de CMS
Configuración de red
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Configuración general de CMS
Configuración de gestión de usuarios

Servidor SMTP

 1. Seleccione el servidor SMTP que desea utilizar. Las opciones proporcionadas son Gmail, Yahoo Mail y Cus-
tom (Personalizado).

 n SMTP Server Site (Sitio del servidor SMTP)
Cuando se selecciona Gmail o Yahoo Mail como servidor SMTP, CMS recuperará automáticamente el 
sitio del servidor de cualquiera de los servidores SMTP.
Cuando se selecciona Custom (Personalizado), los usuarios deben introducir manualmente el sitio del 
servidor SMTP en el campo de entrada.

 n Puerto
Esto se utiliza para cambiar el puerto SMTP a otro puerto.

 n Account (Cuenta)
Configure el nombre de usuario de SMTP introduciendo la cuenta de correo electrónico.

 n Contraseña
Introduzca la contraseña correspondiente de la cuenta de correo electrónico.

Destinatario de correo electrónico

 1. Introduzca la dirección de correo electrónico donde se enviarán las notificaciones de evento/alarma.
 2. Haga clic en Apply (Aplicar) para guardar la configuración.

Configuración de gestión de usuarios
La gestión de usuarios se utiliza para agregar, editar y eliminar las cuentas de usuario de CMS. El nombre de 
usuario y la contraseña del administrador por defecto son Admin y 123456. Acceda al menú de configuración 
de Gestión de usuarios a través de Setup (Configuración) > User Management (Gestión de usuarios).

Fig. 21: Configuración de gestión de usuarios
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Creación de una nueva cuenta de usuario

 1. Haga clic en Add (Agregar) y aparecerá una ventana de configuración.
 2. Introduzca el nombre de usuario y la contraseña que desee para crear una cuenta de usuario.
 3. Haga clic en Apply (Aplicar) para finalizar el proceso y guardar la configuración.

Configuración de una cuenta de usuario

 1. Haga clic en una cuenta de usuario y seleccione Edit (Editar).
 2. Edite el nombre de usuario y la contraseña en la ventana Información del usuario.
 3. Para cambiar la contraseña, haga clic en Change (Cambiar).
 4. Haga clic en OK para guardar y aplicar los ajustes.

AVISO! 
La cuenta "Admin" (Administrador) y la cuenta "Guest" (Invitado) predefinidas no se pueden eliminar. Ade-
más, se recomienda modificar la contraseña predeterminada de "Admin" (Administrador).

Eliminación de una cuenta de usuario

 1. Para eliminar una cuenta de usuario, seleccione la cuenta de usuario deseada y haga clic en Delete (Eli-
minar).

Configuración de permisos de usuario (autoridades)

Establezca los permisos para acceder a las funciones indicadas en el menú de configuración User Mana-
gement (Gestión de usuarios). Haga clic en el elemento de la función para permitir o no el acceso del usuario 
seleccionado.

Icono Definición Icono Definición

Permitir acceso Prohibir acceso

 n Device (Dispositivo): permite/prohíbe que el usuario seleccionado acceda a la pestaña de función Add 
Device (Añadir dispositivo).

 n PTZ: permite/prohíbe al usuario seleccionado controlar las funciones PTZ en el panel de control PTZ de 
la cámara en Live View (Vista en tiempo real).

 n Playback (Reproducción): permite/prohíbe al usuario seleccionado acceder a la pestaña de función 
Playback / Export (Reproducción/exportación) para reproducir/exportar los vídeos.

 n Setup (Configuración): permite/prohíbe al usuario seleccionado entrar en la pestaña de función Setup 
(Configuración) y establecer configuraciones relacionadas con CMS.

La cuenta preestablecida "Guest" (Invitado) solo puede ver la visualización en tiempo real. 

 n Covert IP Camera (Cámara IP oculta): establece qué canales son visibles y cuáles quedan ocultos 
cuando determinadas cuentas de usuario inician sesión.

Configuración general de CMS
Configuración de gestión de usuarios
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Configuración general de CMS
Configuración de gestión de PoE

 1. Haga clic en  (ajuste de ocultación) de la cuenta de usuario deseada para abrir el menú de con-

figuración.

 2. Habilite o deshabilite los canales para ocultar/permitir la visualización de la cámara.
 3. Haga clic en OK para aplicar la configuración. Los usuarios pueden buscar el canal de la cámara usando 

la barra de búsqueda que se encuentra arriba.

Configuración de gestión de PoE
La gestión PoE permite a los usuarios comprobar el estado de cada uno de los puertos PoE y gestionar los 
puertos PoE del conmutador PoE conectado.
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 1. Seleccione PoE Management (Gestión de PoE en la pestaña de función Setup (Configuración) para acce-
der al menú de configuración.

 2. Haga clic en Show PoE Data (Mostrar datos PoE). La ventana "PoE Switch Management" (Administración 
de interruptores PoE) es la siguiente.

Fig. 22: Configuración de la administración de interruptores PoE

N.º Artículo Descripción

1 Re-scan (Volver 
a explorar)

Seleccione una interfaz de la lista desplegable y haga clic en , CMS buscará y 

conectará un conmutador PoE y sus cámaras IP conectadas. Aparecerá un men-
saje de advertencia; haga clic en OK para continuar.

2 PoE Switch 
Topology (Topo-
logía de con-
mutadores PoE)

El número de conmutadores PoE conectados se muestra aquí. El primer icono 
(de izquierda a derecha) representa el CMS y el segundo representa el con-
mutador PoE conectado, y así sucesivamente.

Seleccione el icono del conmutador para mostrar su información relacionada en 
Device Info (Información del dispositivo).

Configuración general de CMS
Configuración de gestión de PoE
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Configuración general de CMS
Configuración de gestión de PoE

N.º Artículo Descripción

3 Device Info 
(Información 
del dispositivo)

Aquí se muestra la información básica del conmutador, incluido el nombre y la 
IP del modelo, la dirección MAC, el ID y la salida de potencia total del con-
mutador. Los usuarios también pueden introducir información breve sobre la 
ubicación del conmutador en la columna "Position" (Posición).

4 PoE Port Mana-
gement (Ges-
tión de puertos 
PoE)

 n RJ45 Port (Puerto RJ45): Este elemento indica el número de puerto PoE.
 n Nombre: Este elemento muestra el nombre de cámara IP.
 n Model (Modelo): Aquí se muestra el nombre del modelo de cámara IP.
 n IP: Aquí se enumera la dirección IP de la cámara IP, que el conmutador 

PoE conectado asigna según el puerto PoE al que está conectada la 
cámara IP.

 n MAC: Aquí se indica la dirección MAC de la cámara IP.
 n Link Status (Estado del enlace): Compruebe aquí el estado de la conexión 

de red de la cámara IP conectada.
 n Link Quality (Calidad del enlace): Compruebe aquí el estado de la cone-

xión de red de la cámara IP conectada.
 n PoE Budget (Capacidad de alimentación PoE): Seleccione AF para esta-

blecer la norma PoE como IEEE 802,3af o seleccione AT para establecer la 
norma PoE como IEEE 802,3at.

 n Power(Watt) (Potencia): Compruebe el consumo de energía del puerto 
PoE.

 n PoE Power (Alimentación PoE): seleccione ON (Activado) para habilitar la 
función PoE en el puerto seleccionado. De lo contrario, seleccione <OFF> 
(Desactivado) para desactivar la función PoE del puerto seleccionado.

 n PoE Status (Estado PoE): Compruebe si el puerto PoE está conectado a 
una cámara IP.
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Add Device (Añadir dispositivo) 
(Conexión de dispositivos IP)
CMS puede buscar y conectar los dispositivos IP a través de la red. Consulte la siguiente 
información para obtener una descripción más detallada de la conexión de un dispositivo 
IP a CMS.

Esta sección contiene la siguiente información:

Ventana Add Device (Añadir dispositivo) 65

Conexión de dispositivos IP 68

Ventana Add Device (Añadir dispositivo)
A continuación se presenta cada uno de los elementos de función del menú de con-
figuración Add Device (Añadir dispositivo).
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Add Device (Añadir dispositivo) (Conexión de dispositivos IP)
Ventana Add Device (Añadir dispositivo)

Fig. 23: Ventana Add Device (Añadir dispositivo)

N.º Artículo Descripción

1 Default Account 
Pane (Panel de 
cuenta pre-
determinada)

Cuando se conecta un dispositivo IP a CMS, CMS aplica automáticamente el 
nombre de usuario/contraseña predeterminados al dispositivo IP según su 
tipo de modelo. Los usuarios pueden modificar el nombre de usuario y la 
contraseña predeterminados para cada tipo de modelo de dispositivos IP.

En la siguiente tabla se enumeran los nombres de cuenta/contraseñas pre-
definidos de cada tipo de dispositivo IP.

Dispositivo IP Nombre de la cuenta Contraseña

Cámara IP Administrador 1234

NVR Administrador 123456

ONVIF Administrador 1234

     

2 Auto Add (Añadir 
automáticamente)

CMS volverá a buscar y añadirá automáticamente las cámaras IP recién 
encontradas mediante esta función. Active la función; también se activará 
"Auto Refresh" (Actualización automática).

Active la casilla "Auto Add" (Añadir automáticamente) para habilitar esta fun-
ción. A continuación, establezca el intervalo de tiempo de Auto Refresh 
(Actualización automática).

3 Auto Refresh (Actua-
lización auto-
mática)

Haga clic en esta casilla y el sistema CMS actualizará automáticamente 
Device List (Lista de dispositivos) cada N segundos. La duración del tiempo 
"N" puede variar entre 30 y 120 segundos.
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N.º Artículo Descripción

4 Re-scan Device (Vol-
ver a explorar dis-
positivos)

Haga clic en .

CMS empezará a volver a buscar las cámaras IP instaladas en la misma LAN, 
ya que CMS cumple con los criterios de búsqueda de Device List (Lista de dis-
positivos).

5 Device Filter (Filtro 
de dispositivos)

Device Filter (Filtro de dispositivos) permite seleccionar el tipo de dis-
positivos IP que se buscarán durante la búsqueda de dispositivos.

Tipo de dispositivo Definición

MOBOTIX MOVE-H.265 Cámaras H.265 IP

MOBOTIX MOVE-H.264 Cámaras IP H.264

NVR NVR

Onvif Cámaras IP Onvif

6 Clear All Device 
(Borrar todos los 
dispositivos)

Haga clic en Clear All Device (Borrar todos los dispositivos) en la esquina 
inferior derecha del monitor y CMS eliminará todos los dispositivos IP conec-
tados.

7 Manually Add (Aña-
dir manualmente)

Puede añadir manualmente un dispositivo IP a CMS. A continuación se des-
cribe esta función en detalle.

8 Device List (Lista de 
dispositivos)

CMS enumerará los dispositivos IP buscados instalados en la misma LAN en 
Device List (Lista de dispositivos). A continuación se describe esta función en 
detalle.

Añadir manualmente dispositivos IP a CMS

Siga los pasos para añadir manualmente un dispositivo IP conocido a CMS.

 1. Haga clic en Manually add (Añadir manualmente). Se añadirá una nueva columna en blanco a Device List 
(Lista de dispositivos).

 2. Introduzca la información esencial del dispositivo IP en los campos correspondientes, incluidos los 
siguientes: <Site Name> (Nombre del sitio), <Type> (Tipo), <IP Address> (Dirección IP), <Protocol> (Pro-
tocolo), <Streaming Port> (Puerto de transmisión), <User Name> (Nombre de usuario) y <Password> 
(Contraseña).

 3. Marque la casilla "Device add to view" (Añadir dispositivo a la vista). CMS comenzará a conectar el dis-
positivo IP.

 4. Para eliminar dispositivos IP añadidos manualmente, simplemente haga clic en el icono de eliminación 

 para cada dispositivo IP. 

AVISO! El rendimiento de una cámara IP puede verse afectado y degradado cuando se conecta y añade 
repetidamente a CMS.

Add Device (Añadir dispositivo) (Conexión de dispositivos IP)
Ventana Add Device (Añadir dispositivo)
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Add Device (Añadir dispositivo) (Conexión de dispositivos IP)
Conexión de dispositivos IP

Device List (Lista de dispositivos)

Al terminar la búsqueda de dispositivos, CMS presentará en Device List (Lista de dispositivos) los dispositivos 
IP instalados en la misma LAN que cumple con los criterios de búsqueda. Puede ver un resumen de con-
figuración de los dispositivos IP encontrados en Device List (Lista de dispositivos), por ejemplo, dirección 
MAC, dirección IP, tipo de modelo, nombre de usuario/contraseña, etc.

 1. Para comprobar la versión de firmware de los dispositivos IP, haga clic en  y se mostrará la versión de 

firmware.

Cambio de vista

En Device List (Lista de dispositivos),  y  se proporcionan para que los usuarios 

puedan cambiar de vista.

 n Detalles: Seleccione esta vista y la información de las cámaras IP aparecerá en columnas, y es posible 
revisar la vista previa de las cámara.

 n Large Icons (Iconos grandes): Seleccione esta vista y los usuarios podrán examinar y comprobar la infor-
mación de las cámaras IP y su vista previa. Tenga en cuenta que cuando la cuadrícula de vista previa 
de una cámara IP indica "Not Supported" (No compatible) o "No Snapshot" (No instantánea), esto 
indica que la cámara IP no es compatible con esta función.

Conexión de dispositivos IP
Los usuarios pueden conectar un dispositivo IP y recuperar su transmisión en tiempo real a CMS. Los dis-
positivos IP son cámaras IP, NVR y codificadores. A continuación se muestra cómo conectar un dispositivo IP 
a CMS.

Añadir cámaras IP a CMS

Siga los pasos que se indican a continuación para buscar y añadir cámaras IP a CMS.

 1. Seleccione <MOBOTIX MOVE-H.265>, <MOBOTIX MOVE-H.264>, <ONVIF> en la lista desplegable Device Fil-
ter (Filtro de dispositivos).

 2. Haga clic en  y CMS comenzará a buscar las cámaras IP compatibles instaladas en la misma LAN y las 

incluirá en Device List (Lista de dispositivos).
 3. Busque la cámara IP que desee en Device List (Lista de dispositivos) y active la casilla "Device add to 

view" (Añadir dispositivo a la vista) para añadir la cama IP a CMS. CMS se conectará y recuperará auto-
máticamente la información de la cámara IP.

Añadir NVR/Codificador a CMS

Los usuarios pueden conectar un NVR/Codificador y recuperar la visualización en tiempo real.
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 1. Seleccione <NVR> o <Codificador> en la lista desplegable Device Filter (Filtro de dispositivos). CMS comen-
zará a buscar los NVR/Codificadores compatibles instalados en la misma LAN y las incluirá en Device List 
(Lista de dispositivos).

 2. Cuando selecciona Codificador, restablece manualmente el nombre de usuario y la contraseña del codi-
ficador o codificadores en Device List (Lista de dispositivos).

 3. Haga clic en el icono Setup (Configuración)  y aparecerá un menú Select Channel (Seleccionar canal) 

tal y como se muestra a continuación. Todas las cámaras IP del NVR/Codificador están en la lista de la 
izquierda; las cámaras IP añadidas a CMS estarán en la lista de la derecha.

 4. Seleccione cualquier cámara IP de la lista de la izquierda, haga clic en  y, a continuación, pulse 

OK. La cámara IP se añadirá a CMS. CMS recuperará la visualización en tiempo real del NVR/Codificador 
conectado.

 5. Para cancelar la conexión de la cámara IP, seleccione la cámara IP en la lista de la derecha, haga clic en 

 y, a continuación, pulse OK. CMS dejará de recuperar la transmisión desde la cámara IP conec-

tada desde el NVR/Codificador.

Desconexión de un dispositivo IP de CMS

 1. Desactivando la casilla "Device add to view" (Añadir dispositivo a la vista) de cualquier dispositivo de la 
lista de dispositivos IP, el dispositivo IP se desconectará. También puede hacer clic en Clear All Device 
(Borrar todos los dispositivos) y CMS desconectará todos los dispositivos IP conectados en Device List 
(Lista de dispositivos).

Actualización del firmware de los dispositivos IP conectados

Puede actualizar el firmware de los dispositivos IP conectados a través de CMS. Siga los pasos que se indican 
a continuación.

Add Device (Añadir dispositivo) (Conexión de dispositivos IP)
Conexión de dispositivos IP
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Add Device (Añadir dispositivo) (Conexión de dispositivos IP)
Conexión de dispositivos IP

 1. Haga clic en el icono de actualización de firmware  del dispositivo en Device List (Lista de dis-

positivos). Aparecerá la ventana "Select File" (Seleccionar archivo).

 2. Designe un archivo de firmware y haga clic en Open (Abrir); a continuación, aparecerá una barra de 
estado de actualización en la página para mostrar el proceso de actualización.

 3. Haga clic en OK en la ventana del mensaje emergente para volver a la pestaña de función Add Device 
(Añadir dispositivo).

Grabación de vídeos desde los dispositivos IP conectados

Una vez conectados los dispositivos IP a CMS, los usuarios pueden decidir grabar vídeos desde determinados 
dispositivos IP conectados a través de la pestaña Record Setup (Configuración de la grabación).

 1. Vaya a Record > Record Schedule (Grabar > Programación de grabaciones).
 2. En la selección de programación de grabación, marque la casilla "R" de los dispositivos IP que desee para 

activar la grabación de CMS.
 3. Asigne una plantilla de programación para los dispositivos IP. CMS comenzará a grabar los vídeos desde 

los dispositivos IP seleccionados. Para obtener más información, consulte el capítulo siguiente, Record 
Setup (Configuración de la grabación).

AVISO! Los usuarios deben asegurarse de que la carpeta de grabación está configurada en Record Setup > 
Record Folder (Configuración de la grabación > Carpeta de grabación).
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Configuración de la grabación
La configuración de la grabación permite a los usuarios decidir qué dispositivos IP conec-
tados van a grabar, establecer la programación de grabaciones para cada cámara IP, etc. A 
continuación se describe cómo configurar la programación de grabación y los ajustes rela-
cionados con los eventos de cada cámara IP conectada.

Esta sección contiene la siguiente información:

Configuración de programación de grabaciones 72

Configuración de grabaciones 73

AVISO! 
Consulte la sección anterior para obtener más información sobre la Configuración de 
eventos.
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Configuración de la grabación
Configuración de programación de grabaciones

Configuración de programación de grabaciones
Los usuarios pueden configurar plantillas de grabación y asignar el tipo de grabación para los días de la 
semana por horas para cada plantilla de grabación.

Fig. 24: Configuración de programación de grabaciones 

Adición/eliminación/cambio de nombre de una plantilla de grabación

 1. Haga clic en  en el panel Recording Template Configuration (Configuración de plantilla de grabación). 

CMS añadirá una nueva plantilla a la lista de plantillas.

 2. Seleccione la plantilla que se ha añadido y haga clic en .

 3. Introduzca el nombre deseado en el campo nombre para cambiar el nombre de la plantilla.
 4. Pulse Enter (Intro) en el teclado para aplicar la configuración.

 5. Para eliminar una plantilla de grabación, seleccione la plantilla y haga clic en . La plantilla de gra-

bación seleccionada se eliminará de la lista de plantillas.

Configuración y asignación de plantillas de grabación

Siga los pasos que se indican a continuación para configurar y asignar una plantilla de grabación.
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Fig. 25: Configuración y asignación de plantillas de grabación

 1. Seleccione una plantilla de grabación en la lista de plantillas.

 2. Haga clic en el tipo de grabación que desee. Se proporcionan tres tipos de grabación: , 

 y .
 n Continuous (Continua): para seguir grabando durante el intervalo de tiempo especificado.
 n No Record (Sin grabación): no graba ni guarda datos de vídeo en el intervalo de tiempo espe-

cificado.
 n Event Only (Solo evento): graba solo cuando ocurre un evento en el intervalo de tiempo espe-

cificado, incluido el vídeo posterior a la alarma.

 3. Haga clic en cualquier parrilla de tiempo para asignar el tipo de grabación seleccionado.
 4. Haga clic en cualquier hora de la parte superior para rellenar la columna.
 5. Haga clic en cualquier día de la parte izquierda para rellenar la función.
 6. Haga clic en la parrilla vacía de la parte superior izquierda para grabar siempre con el tipo de grabación 

seleccionado.
 7. Haga clic y arrastre el ratón para rellenar y asignar el tipo de grabación seleccionado.
 8. Asigne la plantilla a una cámara IP. Seleccione una plantilla que desee en la lista desplegable Schedule 

Template (Plantilla de programación).
 9. Marque la casilla "R" de la cámara IP correspondiente. CMS comenzará la grabación de la transmisión 

recibida desde la cámara IP seleccionada según la plantilla aplicada.

AVISO! 
Si la plantilla de grabación aplicada se elimina de la lista de plantillas, CMS aplicará automáticamente la 
plantilla predeterminada al sitio.

Configuración de grabaciones
En la Carpeta de grabación, se puede asignar el destino del archivo del vídeo grabado y configurar si se habi-
litan las funciones de grabación circular y de duración de los datos de CMS y si se graba el vídeo anterior o 
posterior a la alarma como parte de los vídeos de eventos cuando se produce una alarma o un evento.

Configuración de la grabación
Configuración de grabaciones
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Configuración de la grabación
Configuración de grabaciones

Fig. 26: Configuración de grabaciones 

Carpeta de grabación

El número de carpetas que se pueden seleccionar es igual al número de HDD instalados por el PC, excluyendo 
los HDD con una capacidad inferior a 100 GB.

 1. Marque la casilla y haga clic en la columna de ruta de acceso del archivo para seleccionar y configurar 
más carpetas de destino.

 2. Haga clic en Apply (Aplicar) para completar la configuración.

AVISO! 
Para cambiar el destino del archivo, asegúrese de que la carpeta designada está vacía.

Grabación circular

La grabación circular permite que CMS continúe grabando. CMS borrará los datos registrados anteriores y los 
reemplazará por nuevos datos de vídeo.

Duración de los datos

La función Data Life Time (Duración de los datos) indica la duración máxima de los datos guardados en el 
HDD que se pueden recuperar. Solo los datos registrados dentro de Data Life Time (Duración de los datos) 
estarán disponibles para su búsqueda y reproducción. Los datos de vídeo que superen la duración definida, 
se ocultarán y no se podrán recuperar para su reproducción.

 1. Para activar esta función, marque la casilla "Data Life Time" (Duración de los datos).
 2. Seleccione la hora que desee en el menú desplegable. De lo contrario, desactive x o seleccione <0 day> (0 

días) en el menú desplegable para desactivar la función Data Life Time (Duración de los datos).

AVISO! 
Para reproducir un vídeo que supere el tiempo de duración de los datos, amplíe la duración hasta que se 
incluyan los datos de grabación y el tiempo de grabación del vídeo.

Configuración del comportamiento de alarmas

Es posible configurar la duración de la grabación de vídeo anterior o posterior a una alarma para que forme 
parte de los vídeos de eventos.

 1. Introduzca los segundos que desee en el campo de entrada. El intervalo de duración de "Post-alarm 
Recording" (Grabación posterior a la alarma) es de 15 a 120 segundos, mientras que en el caso de "Pre-
Alarm Recording" (Grabación anterior a la alarma) oscila entre 0 y 120 segundos (0 segundos para des-
activar esta función).

La grabación de vídeo normal DEBE estar habilitada para proporcionar datos de vídeo al vídeo del 
evento correspondiente.

AVISO! 
 Cuando la programación de grabaciones está configurada para grabar solo un evento y se produce un 

74 / 93



evento, CMS solo graba el evento y los vídeos posteriores a la alarma, NO SE GRABARÁN LOS VÍDEOS 
PREVIOS A LA ALARMA.

Configuración de la grabación
Configuración de grabaciones
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Playback/Export 
(Reproducción/exportación)
Los usuarios pueden seleccionar y reproducir/exportar los vídeos grabados en la pestaña 
de función de reproducción/exportación. Además, puede ver las instantáneas y exportar los 
vídeos / instantáneas deseados en esta pestaña de función. En la lista desplegable de la 
parte superior izquierda puede seleccionar el grupo de grabación que desee en el que usar 
las funciones de reproducción / exportación de vídeo.

Esta sección contiene la siguiente información:

Barra de control de reproducción 78

Borrado/protección/marcado de datos 79

Búsqueda/reproducción/exportación de vídeos 82

Búsqueda/reproducción/exportación de vídeos de eventos 85

Búsqueda / Vista / Exportación de instantáneas de eventos 86

7



Playback/Export (Reproducción/exportación)
Barra de control de reproducción

Fig. 27: Playback / export (Reproducción/exportación)

Barra de control de reproducción
La barra de control de reproducción se muestra en la parte inferior de la pantalla.

Fig. 28: Barra de control de reproducción 

Artículo Descripción

Velocidad de reproducción Haga clic y arrastre la barra de control deslizante para ajustar la velocidad 
de avance/retroceso a 1/4, 1/2, 1, 2 o 4.

Rebobinar Haga clic en  para reproducir hacia atrás los vídeos grabados.

Pausa Haga clic en  para hacer una pausa en la reproducción.

Reproducir Haga clic en  para comenzar a reproducir hacia atrás los vídeos grabados.

Clear Time Tag (Borrar eti-
queta de tiempo)

Haga clic en  para borrar la etiqueta de tiempo establecida en la 

barra de tiempo.

Start Export (Iniciar expor-
tación)

Haga clic en  para iniciar el proceso de exportación del vídeo.

Data Erase/Protect (Borra-
r/proteger datos)

Se puede eliminar, proteger y marcar determinadas partes de los vídeos gra-
bados con esta función.

Ayuda de Haga clic para comprobar cómo utilizar la barra de tiempo.
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Borrado/protección/marcado de datos
Puede asignar los datos que deben protegerse contra su eliminación o sobrescritura y definir secciones espe-
cíficas de los datos grabados como marcadores para el uso que sea necesario. Como alternativa, también pue-
den eliminar ciertos datos grabados aquí.

Definición de la protección de datos

Siga estos pasos para definir la protección de datos:

Fig. 29: Definición de la protección de datos

 1. Seleccione cualquier fecha subrayada del calendario, lo que indica que hay datos grabados disponibles. 
La franja amarilla de la barra de tiempo indica que hay vídeos grabados disponibles.

 2. Haga clic y arrastre el icono de intervalo de tiempo  y suéltelo en la barra de tiempo para seleccionar 

el intervalo de vídeo que desea grabar.

 3. Utilice el icono Ajuste de intervalo de tiempo  para ajustar el segmento de tiempo que desee. Gire 

hacia arriba o hacia abajo la rueda del ratón para acercar o alejar la imagen y seleccionar la hora exacta 
que desee.

 4. Haga clic en  y seleccione . Aparecerá una ventana de confirmación.

Playback/Export (Reproducción/exportación)
Borrado/protección/marcado de datos
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Playback/Export (Reproducción/exportación)
Borrado/protección/marcado de datos

 5. Haga clic en OK para continuar con el procedimiento. El icono de eliminación/protección de datos cam-
biará a color azul claro, lo que indica que la protección de datos se está realizando. Una vez hecho esto, 
el icono vuelve a cambiar a color gris. La franja de tiempo de datos protegidos aparecerá en verde en la 
barra de tiempo tal y como aparece en la siguiente figura.

Cancelación de la protección de datos

Hay dos formas de cancelar la protección de datos si fuera necesario.

Uso de la barra de tiempo

 1. Seleccione y ajuste la franja de tiempo de datos protegidos en la barra de tiempo mediante los iconos de 

intervalo de tiempo  y de ajuste de intervalo de tiempo .

 2. Haga clic en  y seleccione .

 3. Aparece una ventana de confirmación; haga clic en OK para continuar. La franja de tiempo seleccionada 
cambiará a color amarillo, lo que indica que esta parte de los datos grabados no está protegida y se 
puede eliminar o sobrescribir.

Uso de la lista de protección

 1. Haga clic en  y seleccione . Toda la información protegida aparecerá en 

Protection List (Lista de protección).

 2. Haga clic en  del elemento de datos que desee y seleccione <OK> en la ventana emergente de con-

firmación. Se eliminarán los datos seleccionados.

Borrado de datos

Siga estos pasos para borrar los datos grabados deseados de la base de datos del NVR.

 1. Siga los pasos del 1 al 3 de la Definición de la protección de datos para establecer qué parte de los vídeos 
grabados se va a eliminar de la base de datos.
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 2. Haga clic en  y seleccione . Aparece una ventana de confirmación; haga clic 

en <OK> para proceder al borrado de datos. Los datos seleccionados se eliminarán de la barra de tiempo 
tal y como se muestra a continuación.

Marcador de datos

Siga estos pasos para marcar una sección de los datos grabados.

 1. Siga los pasos 1 a 3 de la Definición de la protección de datos para establecer qué parte de los vídeos gra-
bados se va a marcar.

 2. Haga clic en  y seleccione . La lista de marcadores aparece tal y como se 

muestra a continuación.

Playback/Export (Reproducción/exportación)
Borrado/protección/marcado de datos
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Playback/Export (Reproducción/exportación)
Búsqueda/reproducción/exportación de vídeos

 3. Asigne un nombre al marcador en "Describe" (Describir).
 4. Haga clic en Add (Añadir). Aparece un cuadro de diálogo de confirmación, haga clic en OK para continuar. 

A continuación, aparece otro cuadro de diálogo de confirmación en el que se pregunta si se desea pro-
teger el vídeo o no.

 5. Haga clic en OK para protegerlo o haga clic en Cancel (Cancelar) para crear un marcador.

Reproducción/eliminación de marcadores

 1. Haga clic en  y seleccione  para ver Bookmark List (Lista de marcadores).

 2. Para reproducir el vídeo marcado, haga clic en . El CMS comenzará a reproducirse.

 3. Para eliminar un marcador, haga clic en .

 4. Haga clic en OK para eliminar el marcador.

Búsqueda/reproducción/exportación de vídeos
Los usuarios pueden buscar y reproducir los vídeos grabados por fecha/hora. Consulte el apartado siguiente 
para obtener más instrucciones.

Búsqueda y reproducción de vídeos por tiempo / por HD 
múltiple

En esta sección se describe cómo buscar y reproducir el vídeo que se haya grabado. En <Local Playback By 
Multiple HD> (Reproducción local por HD múltiple), CMS también permite que los usuarios reproduzcan 
vídeos en modo de 4 ventanas con resolución de 1080p.

AVISO! Asegúrese de que la resolución de vídeo de los datos grabados es de 1080p o superior.
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Fig. 30: Búsqueda y reproducción de vídeos por tiempo / por HD múltiple

 1. Seleccione Local Playback By Time (Reproducción local por tiempo), Remote NVR Playback (Repro-
ducción del NVR en forma remota) o Local Playback By Multiple HD (Reproducción local por HD múl-
tiple) y siga estos pasos para buscar y reproducir los vídeos grabados que desee. 

 2. Seleccione cualquier fecha subrayada del calendario, lo que indica que hay datos grabados disponibles. 
La franja amarilla de la barra de tiempo muestra que hay vídeos grabados para que los usuarios los repro-
duzcan.

 3. Haga clic y arrastre la barra de tiempo para seleccionar la hora que desee en la barra. La hora selec-
cionada aparece encima del indicador azul.

 4. Mueva el cursor del ratón a la barra de tiempo, gire hacia arriba o hacia abajo la rueda del ratón para ajus-
tar la escala de tiempo y seleccione la hora exacta deseada.

 5. Al seleccionar Local Playback By Multiple HD (Reproducción local por HD múltiple), marque las cuatro 
casillas de canal con datos grabados de <Select channels to: (Seleccionar canales a).

 6. Haga clic en  para iniciar la reproducción del vídeo seleccionado.

Exportación de vídeos por tiempo

Siga estos pasos para exportar vídeos normales.

AVISO! 
Esta función no está disponible para los vídeos grabados en la ubicación remota del NVR.

Playback/Export (Reproducción/exportación)
Búsqueda/reproducción/exportación de vídeos
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Playback/Export (Reproducción/exportación)
Búsqueda/reproducción/exportación de vídeos

Fig. 31: Exportación de vídeos por tiempo

 1. Seleccione la fecha sombreada que desee en el calendario. La barra de tiempo mostrará los datos gra-
bados disponibles de cada canal.

 2. Haga clic y arrastre el icono de intervalo de tiempo  hasta la barra de tiempo para seleccionar el inter-

valo de tiempo deseado del vídeo grabado.

 3. Haga clic y arrastre el icono Ajuste de intervalo de tiempo  para ajustar el segmento de tiempo que 

desee. Gire hacia arriba o hacia abajo la rueda del ratón para acercar o alejar la imagen y seleccionar la 
hora exacta.

 4. Haga clic en . Aparecerá la ventana "Select File Path" (Seleccionar ruta de archivo). Asigne una 

ruta de acceso al archivo y haga clic en Select Folder (Seleccionar carpeta). Aparecerá la ventana Export 
(Exportar).

 5. Marque las casillas de los canales que se van a exportar.
 6. Seleccione el formato de vídeo para el vídeo que se va a exportar. Los formatos de vídeo que puede elegir 

son *.avi, *.raw, *.mp4, *.mkv y *.mov.
 7. Active o desactive la casilla "Audio Export" (Exportación de audio) para exportar vídeos con o sin audio si 

el vídeo se graba con audio.
 8. Haga clic en Confirm (Confirmar) para iniciar la exportación del vídeo.
 9. Haga clic en OK en la ventana de mensaje emergente después de exportar el vídeo para volver a la pes-

taña de función Playback / Export (Reproducción/exportación).
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Búsqueda/reproducción/exportación de vídeos de 
eventos
Además de buscar vídeos grabados en función del tiempo, los usuarios pueden buscar, reproducir y exportar 
vídeos de eventos.

Búsqueda y reproducción de vídeos de eventos

Se pueden buscar eventos por hora, canal o tipo. Siga estos pasos para buscar vídeos de eventos.

Fig. 32: Búsqueda y reproducción de vídeos de eventos

 1. Haga clic en la barra "Local Playback By Event" (Reproducción local por evento), en la barra "Video Ana-
lysis by Event" (Análisis de vídeo por evento) o en la barra "Remote NVR Playback By Event" (Repro-
ducción del NVR en forma remota por evento) para ver el Event Search Filter (Filtro de búsqueda de 
eventos).

 2. En Event Search Filter (Filtro de búsqueda de eventos), active la casilla "Search By Date / Time" (Buscar 
por fecha / hora) y especifique las horas de inicio/finalización para la búsqueda de eventos.

 3. Active la casilla "Search by Channel" (Buscar por canal) y seleccione los canales deseados en los que bus-
car eventos.

 4. Marque la casilla "Search by Type" (Buscar por tipo) y designe qué tipo de evento se incluirá en la bús-
queda de eventos.

 5. Los usuarios que seleccionan la barra "Local Playback By Event" (Reproducción local por evento) o la 
barra "Remote NVR Playback By Event" (Reproducción del NVR en forma remota por evento), deben mar-
car la casilla "Search By Index" (Buscar por índice) y seleccionar el índice de movimiento que desean bus-
car.

Playback/Export (Reproducción/exportación)
Búsqueda/reproducción/exportación de vídeos de eventos
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Playback/Export (Reproducción/exportación)
Búsqueda / Vista / Exportación de instantáneas de eventos

 6. Haga clic en Search (Buscar) para presentar los vídeos de eventos que cumplen los criterios de bús-
queda. Event List (Lista de eventos) muestra los eventos por fecha/hora, por tipo de evento y por cámara 
activada en orden cronológico.

 7. Seleccione cualquier evento en Event List (Lista de eventos) y la ventana de visualización de la derecha 
comenzará a reproducir el evento seleccionado.

Exportación de vídeos de eventos

Siga los pasos que se indican a continuación para exportar vídeos de eventos. Esta función no está disponible 
para los vídeos grabados en la ubicación remota del NVR.

 1. Seleccione el evento que desee de Event List (Lista de eventos).

 2. Haga clic en . Aparecerá la ventana "Select File Path" (Seleccionar ruta de archivo).

 3. Asigne una ruta de acceso al archivo y haga clic en Select Folder (Seleccionar carpeta). Aparecerá la ven-
tana Export (Exportar).

 4. Seleccione el formato de vídeo para el vídeo que se va a exportar. Los formatos de vídeo que puede elegir 
son *.avi, *.raw, *.mp4, *.mkv y *.mov.

 5. Active o desactive la casilla "Audio Export" (Exportación de audio) para exportar vídeos con o sin audio si 
el vídeo se graba con audio.

 6. Haga clic en Confirm (Confirmar) para iniciar la exportación del vídeo.
 7. Después de exportar el vídeo, haga clic en OK en la ventana de mensaje emergente para volver a la pes-

taña de función Playback / Export (Reproducción/exportación).

Búsqueda / Vista / Exportación de instantáneas de 
eventos
Las instantáneas de eventos capturadas se almacenan en CMS. Puede buscar, consultar y exportar las ins-
tantáneas capturadas en la pestaña de la función Playback / Export (Reproducción/exportación). A con-
tinuación se presenta cada uno de los elementos de <Instantánea por evento > y se indica cómo buscar 
instantáneas de eventos.
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Fig. 33: Búsqueda, vista y exportación de instantáneas de eventos

N.º Artículo Icono Descripción

1 Previsualización - Aquí se muestra la vista previa de la instantánea en Snapshot List 
(Lista de instantáneas).

2 Seleccionar Todo Haga clic en  para seleccionar todas las instantáneas de Snapshot 

List (Lista de instantáneas). Los usuarios pueden hacer clic en los ico-
nos Export (Exportar) o Delete (Eliminar) para exportar o eliminar 
todos los archivos.

3 Exportar Seleccione el archivo o archivos de instantánea y haga clic en  

para exportarlo.

4 Borrar Seleccione los archivos de instantánea en Snapshot List (Lista de ins-

tantáneas) y haga clic en  para eliminarlos sin aviso.

5 Snapshot List 
(Lista de ins-
tantáneas)

- Aquí se enumeran todas las imágenes capturadas.

Haga clic en cualquier imagen en miniatura para obtener una vista 
previa de la información seleccionada y relacionada en el Snapshot 
Information Pane (Panel de información de instantánea).

6 Snapshot Infor-
mation (Infor-
mación de 
instantánea)

- Seleccione cualquier imagen capturada de Snapshot List (Lista de ins-
tantáneas) y la información que le corresponde (incluida la 
fecha/hora de captura, la resolución de la imagen y el tamaño de la 
imagen) se indica en este panel.

Búsqueda y visualización de instantáneas de eventos

Se pueden buscar instantáneas de eventos por hora, canal o tipo. Siga estos pasos para buscar instantáneas 
de eventos.

Playback/Export (Reproducción/exportación)
Búsqueda / Vista / Exportación de instantáneas de eventos
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Playback/Export (Reproducción/exportación)
Búsqueda / Vista / Exportación de instantáneas de eventos

 1. Haga clic en la barra de Snapshot By Event (Instantánea por evento) para mostrar el Event Search Filter 
(Filtro de búsqueda de eventos).

 2. En Event Search Filter (Filtro de búsqueda de eventos), active la casilla "Search By Time" (Buscar por 
hora) y especifique las horas de inicio/finalización para el rango de tiempo de la búsqueda de eventos.

 3. Active la casilla "Search By Channel" (Buscar por canal) y seleccione los canales deseados para la bús-
queda de eventos.

 4. Marque la casilla "Search By Type" (Buscar por tipo) y designe qué tipo de evento (Movimiento, Pérdida 
de vídeo o Alarma) se incluirá en la búsqueda de eventos.

 5. Marque la casilla "Search By Index" (Buscar por índice) y seleccione el índice de movimiento que desea 
buscar.

 6. Haga clic en Search (Buscar) para presentar las instantáneas de eventos que cumplen los criterios de bús-
queda que se indican arriba. Las instantáneas de eventos que se han filtrado aparecen en la lista de ins-
tantáneas.

Exportación de instantáneas

Siga estos pasos para exportar instantáneas de eventos.

 1. Seleccione un archivo o archivos de instantáneas y haga clic en .

 2. Designe una ruta de archivo desde la ventana "Select File Path" (Seleccionar ruta de archivo) y haga clic 
en Select Folder(Seleccionar carpeta). Aparecerá la ventana Export (Exportar).

 3. Confirme la información en la ventana Export (Exportar); haga clic en Confirm (Confirmar) para iniciar la 
exportación.

 4. Haga clic en OK en la ventana del mensaje emergente para volver a la pestaña de función Pla-
yback/Export (Reproducción/exportación).
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Registro
Haga clic en Log (Registro) para acceder al menú Log (Registro). En la pestaña de función 
Log (Registro), los usuarios pueden comprobar, ver, buscar y exportar los datos de registro. 
Consulte la siguiente información para obtener más detalles.

Fig. 34: Registro

8



Registro
Búsqueda de datos de registro

Búsqueda de datos de registro
El CMS divide los datos de registro en cuatro categorías: operaciones de usuarios, eventos de cámara IP, even-
tos de VA detectado, eventos del NVR en forma remota y eventos del conmutador POE. Seleccione el ele-
mento de la categoría de registro que desee a la izquierda de la pestaña Log (Registro) para entrar en su 
menú de registro correspondiente. Consulte los siguientes pasos para buscar y ver los datos del registro.

 1. Establezca el intervalo de tiempo de la búsqueda de datos de registro asignando la Fecha de inicio y la 
Fecha de finalización en la parte superior izquierda de la pestañas de función.

 2. Cuando seleccione "Registro de eventos de la cámara IP" o "Registro de eventos de VA detectados", 
active los tipos de sucesos deseados en el Panel de opciones.

 3. Haga clic en Search (Buscar). CMS comenzará la búsqueda y, a continuación, enumerará todos los datos 
de registro registrados dentro del tiempo establecido.

 4. Haga clic en cada elemento de categoría de registro situado a la izquierda del menú Log (Registro) para 
ver sus correspondientes datos de registro encontrados dentro del tiempo establecido.

Exportación de datos de registro
Los datos de registro se pueden exportar si es necesario. Los datos de registro se exportarán en formato de 
archivo *.txt.

 1. En el menú del tipo de registro deseado, haga clic en el icono Seguridad de registro  situado en la 

esquina superior derecha de la pestaña Log (Registro).
 2. Designe una ruta de archivo desde la ventana "Select File Path" (Seleccionar ruta de archivo) y haga clic 

en Select Folder(Seleccionar carpeta). Aparecerá la ventana Export (Exportar).
 3. Compruebe la información en la ventana Export (Exportar); haga clic en Confirm (Confirmar) para iniciar 

la exportación.
 4. Haga clic en OK en la ventana del mensaje emergente para volver a la pestaña de función Log (Registro).
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